Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko Epson Corporation. The information contained herein is designed only for use with this Epson product. Epson is not responsible for any use of this information as applied to other equipment.

Neither Seiko Epson Corporation or its affiliates shall be liable to the purchaser of this product or third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation’s operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or any consumable products other than those designated as Original Epson Products or Epson Approved Products by Seiko Epson Corporation.

Responsible Use of Copyrighted Materials

Digital cameras, scanners, and ink jet printers, like conventional photocopiers and cameras, can be misused by improper copying or printing of copyrighted material. While some countries’ laws permit limited copying of copyrighted material in certain circumstances, those circumstances may not be as broad as some people assume. Epson encourages each user to be responsible and respectful of the copyright laws when using digital cameras, scanners, and ink jet printers.

Trademarks

Epson, Epson Stylus, and Epson Photo Stickers are registered trademarks and Epson Smart Panel, PRINT Image Matching, and the PRINT Image Matching logo are trademarks of Seiko Epson Corporation.

ColorLife, RPM, and BorderFree are registered trademarks; PremierArt, PhotoEnhance, and Resolution Performance Management are trademarks; and Epson Connection, Epson Store, and SoundAdvice are service marks of Epson America, Inc.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. Epson disclaims any and all rights in those marks.
Contents

Welcome! ................................................................. 7
What Your RX500 Can Do .............................................. 8
About Your Documentation ........................................... 10
  Warnings, Cautions, Notes, and Tips ......................... 10
About Your Software .................................................. 11

Loading Paper .......................................................... 13
Loading Single Sheets ................................................. 13
Loading Envelopes .................................................... 17

Copying ................................................................. 19
Copying Without a Computer ........................................ 19
  Changing the Copy Layout ...................................... 24
  Making Copies Lighter or Darker ............................... 26
  Saving and Reusing Copy Settings ............................. 26
  Adjusting the Copy Size Manually ........................... 27
  Canceling Copies ................................................. 27
  Restoring Default Settings .................................... 27
Copying With a Computer ............................................ 28

Printing From a Computer ........................................... 35
Printing in Windows .................................................. 36
  Selecting Default Settings .................................... 38
Customizing Windows Print Settings ............................. 39
Printing Photos in Windows ......................................... 41
Printing on a Macintosh ............................................. 43
  Printing With OS X .............................................. 43
  Printing With OS 8.6 to 9.x ................................. 47
Customizing Macintosh Print Settings ........................................ 49
  Customizing OS X Print Settings ......................................... 49
  Customizing OS 8.6 to 9.x Print Settings ............................. 50
Printing Photos on a Macintosh ............................................. 51
  Printing Photos With OS X ............................................... 52
  Printing Photos With OS 8.6 to 9.x ..................................... 53
Selecting Your Paper Type .................................................... 54

**Scanning to a Computer** .................................................. 57
  Using Epson Smart Panel .................................................. 58
  Scanning to a File .......................................................... 60
  Scanning From a Program .................................................. 63
    Adjusting the Scan Area (Marquee) .................................. 67
  Restoring Color to Old Photographs .................................... 68
    Placing Your Photo and Loading Paper ............................... 68
    Restoring and Saving Photos to Your Computer ..................... 70
    Restoring and Printing Photos ....................................... 73
Scanning Slides and Film .................................................... 74
  Scanning Using the RX500 Buttons ..................................... 79
    Scanning to Your Computer .......................................... 79
    Scanning to E-Mail ..................................................... 81

**Using Memory Cards** ...................................................... 83
  Compatible Memory Cards ................................................ 83
  Inserting and Removing Cards ......................................... 84
  Copying Photos to Your Computer ...................................... 85
    Windows and OS 8.6 to 9.x ......................................... 86
    Macintosh OS X ....................................................... 87
Printing From a Memory Card ................................................. 89
Printing an Index Form ....................................................... 89
Selecting Photos To Print .................................................... 92
Printing With DPOF ........................................................... 94
Choosing Print Settings ....................................................... 96
Scanning a Photo to a Memory Card ...................................... 105

Maintaining the RX500 ....................................................... 109
Cleaning the Print Head ...................................................... 109
Replacing Ink Cartridges ..................................................... 111
Installing New Cartridges .................................................... 111
Aligning the Print Head ....................................................... 115
Transporting the RX500 ...................................................... 118

Solving Problems ............................................................ 121
Problems and Solutions ...................................................... 121
Copying Problems ............................................................ 121
Paper Feeding Problems ..................................................... 122
Copy Quality Problems ....................................................... 122
Where To Get Help ............................................................ 123
Epson Support ................................................................. 123
Other Software Technical Support ........................................ 124

Contents 5
Welcome!

The Epson Stylus® Photo RX500 combines the convenience of scanning and stand-alone copying with true photo print quality. It includes these features:

■ Lets you print directly from your memory card, without even turning on your computer. Three built-in memory card slots support CompactFlash™ Type I and II, SD (Secure Digital), miniSD, MMC (MultiMediaCard), xD-Picture Card, SmartMedia™, Sony® Memory Stick®, Memory Stick PRO, Memory Stick Duo™, MagicGate™ Memory Stick, and IBM® Microdrive.

■ Serves as an external card reader that lets you copy images from the memory card to your computer, or vice versa.

■ Includes photo restoration features to restore faded color photos to their original brilliance.

■ Includes a built-in transparency unit and film holder so you can transform your slides and 35 mm film into beautiful photographs.

■ Supports DPOF (Digital Print Order Format) technology, so you can pre-select the photos you want to print while your memory card is still in the camera. (Your digital camera must also support DPOF.)

■ Includes software that lets you scan and edit text, or scan a photo and attach it to an e-mail. You can also upload photographs, free of charge, to Epson’s photo-sharing web site.

■ Supports Epson’s BorderFree® print technology, which lets you print without borders on a variety of popular paper sizes.

■ Supports Epson’s PRINT Image Matching™ technology and the Exif (Exchangeable Image File) Print format. With both technologies, your digital camera saves specific printing information, such as gamma level and color saturation, with each JPEG or TIFF image file. Your RX500 detects that information and uses it to optimize your print.

You can print P.I.M. or Exif images directly from your memory card using the RX500’s buttons, or you can use ArcSoft® PhotoImpression™, one of the bonus applications that comes with your RX500.
# What Your RX500 Can Do

You can do a lot with your RX500! Look at the table below to find information on many of the available features.

<table>
<thead>
<tr>
<th>Original</th>
<th>Equipment</th>
<th>What you can do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text document</td>
<td>RX500</td>
<td><strong>Copy</strong>: Use the RX500 as a copy machine to create duplicates of black and white or color documents. See page 19.</td>
</tr>
<tr>
<td></td>
<td>RX500 + Computer</td>
<td><strong>Copy</strong>: Use Epson Smart Panel™ Copy Center to create copies. See page 28. <strong>Print</strong>: See page 36 (Windows®) or page 43 (Macintosh®). <strong>Scan</strong>: See page 57. To scan editable text, see Smart Panel Help.</td>
</tr>
<tr>
<td>Photos</td>
<td>RX500</td>
<td><strong>Copy</strong>: Use the RX500 as a copy machine to create duplicate photos. See page 19. <strong>Scan to memory card</strong>: Scan photos and save the image files on a memory card. See page 105.</td>
</tr>
<tr>
<td></td>
<td>RX500 + Computer</td>
<td><strong>Copy</strong>: Use Epson Smart Panel™ Copy Center to create copies. See page 28. <strong>Print</strong>: See page 36 (Windows) or page 43 (Macintosh). <strong>Scan</strong>: See page 57. <strong>Scan to computer or e-mail</strong>: Scan using the RX500 buttons. See page 79.</td>
</tr>
<tr>
<td>Original</td>
<td>Equipment</td>
<td>What you can do</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Film and Slides                 | RX500 + Computer     | **Scan**: Scan film or slides with Epson® Scan. See page 60.  
**Print photos**: Scan and print photos from film using the Reprint Photos option in Epson Smart Panel. See Smart Panel Help. |
| Memory Card Photos              | RX500 + Computer     | **Print**: See page 89.  
**Use the RX500 as a card reader**: Save backups of memory card photos when you insert a memory card in the RX500 and connect it to your computer. See page 85. |
| Faded Photos, Film, and Slides  | RX500 + Computer     | **Scan and restore color**: Restore color and fix other flaws using Epson Scan. See page 68.  
**Print and restore color**: Restore color when scanning and printing with the Reprint Photos option. See page 73. |
| Fax                             | RX500 + Computer     | **Fax**: Use Epson Smart Panel and your own fax software. See Smart Panel Help.                                                                 |
About Your Documentation

To set up your RX500 and install its software, see the Start Here sheet.

For easy instructions on how to copy a 4 × 6-inch photo or print images from your digital camera's memory card, see the How to Copy and Print guide.

This book contains system requirements, important safety information, your warranty, and instructions on:

■ Loading paper
■ Copying with and without a computer
■ Using the printer software for basic and advanced printing, including instructions for creating borderless prints
■ Using the scanning software to produce high-quality scans of all your photos and documents
■ Using a memory card, including supported cards and the correct way to insert and remove a card
■ Maintaining the RX500
■ Solving basic problems

At the end of the book, you’ll find an index.

For specifications and more detailed instructions on using and maintaining the RX500, see your on-screen Reference Guide. To view it, just double-click its icon on your desktop.

Warnings, Cautions, Notes, and Tips

Please follow these guidelines:

Warnings must be followed carefully to avoid bodily injury.
Cautions must be observed to avoid damage to your equipment.
Notes contain important information about your RX500.
Tips contain hints for better copying, scanning, and printing.
About Your Software

Your Epson CD-ROM includes all the software you need to scan, copy, or print from your computer. See the Start Here sheet for installation instructions.

■ Your printer driver runs your printer and lets you control how your documents look. You can't print from your computer without it.

■ Your scanner software (Epson Scan) runs your scanner and lets you control how your scans look. You can't scan from your computer without it.

Tip:
It's a good idea to check Epson's support website periodically for free updates to your printer and scanner software. Visit http://support.epson.com. Download instructions are posted for your convenience.

■ Your on-screen Reference Guide gives you complete information about your RX500. To view the on-screen Reference Guide, you need a browser, such as Microsoft® Internet Explorer® 4.0 or later, Netscape Navigator® 3.0 or later, or Safari™ 1.0 or later. If you're using a different browser, the pages may not display correctly. (A browser is not included on the Epson CD-ROM.)

Note:
You can view the Reference Guide by double-clicking the SP RX500 Reference Guide icon on your desktop.

■ Your Epson CD-ROM also includes these great tools:

  ■ Epson Smart Panel, an easy, step-by-step program for scanning, copying, printing, and more.

  ■ ArcSoft® PhotoImpression® an easy-to-use photo management program that lets you edit, retouch, and enhance images, or print your images with templates, frames, and borders.
Loading Paper

Follow the guidelines below to load single sheets in the RX500. For a list of Epson papers and ordering information, see the inside back cover of this manual.

Loading Single Sheets

1. Open the output tray.

2. Flip the feeder guard forward.
3. Pinch the sides of the left edge guide together as you slide the guide all the way to the left.

4. Insert your paper against the right edge of the sheet feeder, behind the tab.
   
   **Note:**
   Don’t place the paper in front of the feeder guard.

5. Press the sides of the left edge guide together and slide against the paper (but not too tightly).
6. Flip the feeder guard back over the paper.

![Feeder guard]

Also be sure to:
- Load all paper with the printable side up. It’s usually brighter or whiter.
- Always load the short edge first, even when printing on 4 × 6-inch paper.
- Don’t load paper above the arrow on the left edge guide.
- Load letterhead or preprinted paper top edge first.
- Don’t load paper above the arrow on the left edge guide.

To load Epson ink jet papers, follow the guidelines below. Check the paper package for additional instructions.

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Loading capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Premium Bright White Paper</td>
<td>80 sheets</td>
</tr>
<tr>
<td>Epson Photo Quality Ink Jet Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Photo Quality Ink Jet Cards</td>
<td>30 cards</td>
</tr>
<tr>
<td>Epson Ink Jet Transparencies</td>
<td>30 sheets</td>
</tr>
<tr>
<td>Paper type</td>
<td>Loading capacity</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Epson Matte Paper Heavyweight</td>
<td>20 sheets</td>
</tr>
<tr>
<td>PremierArt™ Matte Scrapbook Photo Paper for Epson</td>
<td></td>
</tr>
<tr>
<td>Epson Photo Paper</td>
<td></td>
</tr>
<tr>
<td>Epson All-Purpose Glossy Photo Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Glossy Photo Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Premium Glossy Photo Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Premium Semigloss Photo Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Semigloss Scrapbook Photo Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Glossy Photo Greeting Cards</td>
<td>10 cards</td>
</tr>
<tr>
<td>Epson Iron-On Transfer Paper</td>
<td>1 sheet</td>
</tr>
<tr>
<td>Epson Photo Quality Self Adhesive Sheets</td>
<td></td>
</tr>
<tr>
<td>Epson Double-Sided Matte Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Premium Luster Photo Paper</td>
<td></td>
</tr>
<tr>
<td>Epson ColorLife® Photo Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Photo Stickers®</td>
<td></td>
</tr>
</tbody>
</table>
Loading Envelopes

1. Open the output tray.

2. Flip the feeder guard forward.

3. Load up to 10 envelopes at a time against the right edge of the sheet feeder, beneath the tab. Always load envelopes short edge first, with the flap edge to the left and the printable side up.

   **Note:**
   Don’t place the envelopes in front of the feeder guard.
4. Press the sides of the left edge guide together and slide it against the envelopes (but not too tightly).

**Note:**
For best results, press each envelope flat before loading, or load one envelope at a time. Avoid envelopes that are too thin; they may curl during printing.

Select the following settings when printing on envelopes:

- **Plain paper** as the Type (Windows) or Media Type (Macintosh) setting
- **Landscape** as the Orientation setting
- The correct envelope size as the Size (Windows) or Paper Size (Macintosh) setting

For instructions on selecting these settings, see:

- “Printing in Windows” on page 36
- “Printing on a Macintosh” on page 43
Copying

Follow the instructions in this chapter to use your RX500 as a photocopier, or to copy with a computer using the Epson Smart Panel software.

- “Copying Without a Computer” below
- “Copying With a Computer” on page 28

Copying Without a Computer

1. Open the scanner lid.

2. Place your photo or document face down on the glass, in the upper left corner. Move your document about 0.1 inch from the top and side edge so your entire document is scanned.

   ![Orient the photo as shown]

   ![Move the photo or document in about 0.1 inch from the edges]

   Note:
   If you place your photo flush against the guides, the edges next to the guides may not be copied.
3. Close the scanner lid.

![Image of printer with scanner lid open]

**Note:**
To copy a thick document such as a book, you can remove the scanner lid. Open the scanner lid completely. Then disconnect the cord from the TPU connector and pull the lid straight up. Turn on the RX500 and gently press down the original to keep it flat on the scanner glass as you scan. When you’re finished, be sure to turn off the RX500 before replacing the scanner lid and plugging in the connector.

4. Open the output tray.

![Image of printer with output tray open]

5. Flip the feeder guard forward.

![Image of printer with feeder guard flipped forward]
6. Pinch the sides of the left edge guide together as you slide the guide all the way to the left.

7. Insert your paper against the right edge of the sheet feeder, behind the tab.
   
   **Note:**
   Don’t place the paper in front of the feeder guard.

8. Press the sides of the left edge guide together and slide against the paper (but not too tightly).

9. Flip the feeder guard back over the paper.

10. Press the **Copy** button to set the RX500 to copy mode.
11. Make sure you see Standard at the top of the LCD screen. This prints a photo or document with borders. If you want to select a different setting, such as a photo with no borders, press the Menu button, then see “Changing the Copy Layout” on page 24.

After a few seconds, the current copy settings display on the LCD screen:

12. Use the RX500 numeric keypad to select the number of copies you want to print.

13. Press the top left button to choose your paper type:

<table>
<thead>
<tr>
<th>Use this paper type</th>
<th>When you’ve loaded</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain</td>
<td>Plain paper</td>
</tr>
<tr>
<td></td>
<td>Epson Premium Bright White Paper</td>
</tr>
<tr>
<td></td>
<td>Epson Photo Quality Ink Jet Paper</td>
</tr>
<tr>
<td></td>
<td>Epson Photo Quality Ink Jet Cards</td>
</tr>
<tr>
<td></td>
<td>Epson Iron-on Transfer Paper</td>
</tr>
<tr>
<td></td>
<td>Epson Photo Quality Self Adhesive Sheets</td>
</tr>
<tr>
<td>Glossy</td>
<td>Epson Glossy Photo Paper</td>
</tr>
<tr>
<td></td>
<td>Epson Photo Paper</td>
</tr>
<tr>
<td></td>
<td>Epson All-Purpose Glossy Paper</td>
</tr>
<tr>
<td></td>
<td>Epson Glossy Photo Greeting Cards</td>
</tr>
<tr>
<td>Prem. Glossy</td>
<td>Epson Premium Glossy Photo Paper</td>
</tr>
<tr>
<td></td>
<td>Epson Premium Semigloss Photo Paper</td>
</tr>
<tr>
<td></td>
<td>Epson Photo Stickers</td>
</tr>
<tr>
<td>Prem. Luster</td>
<td>Epson Premium Luster Photo Paper</td>
</tr>
<tr>
<td>Matte</td>
<td>Epson Matte Paper Heavyweight</td>
</tr>
<tr>
<td></td>
<td>Epson Double-Sided Matte Paper</td>
</tr>
<tr>
<td></td>
<td>PremierArt Matte Scrapbook Photo Paper for Epson</td>
</tr>
<tr>
<td>ColorLife</td>
<td>Epson ColorLife Photo Paper</td>
</tr>
<tr>
<td></td>
<td>Epson Semigloss Scrapbook Photo Paper</td>
</tr>
</tbody>
</table>
14. Press the bottom left button to choose print quality.

<table>
<thead>
<tr>
<th>Choose this quality setting</th>
<th>When you want to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draft</td>
<td>Make copies quickly, and copy quality isn’t important</td>
</tr>
<tr>
<td>Text</td>
<td>Print text and line art</td>
</tr>
<tr>
<td>Photo</td>
<td>Print photos at high resolution</td>
</tr>
<tr>
<td>Best</td>
<td>Print photos and other documents at highest resolution</td>
</tr>
</tbody>
</table>

15. Press the top right button to set the size of your printed copy.

<table>
<thead>
<tr>
<th>Choose this setting</th>
<th>When you want to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actual</td>
<td>Print the image at its original size</td>
</tr>
<tr>
<td>Auto Fit Page</td>
<td>Reduce or enlarge the image to fit the selected paper size</td>
</tr>
<tr>
<td>Letter → 4 × 6</td>
<td>Convert the original document size (to the left of the arrow) to the finished copy size (to the right of the arrow)</td>
</tr>
<tr>
<td>4 × 6 → Letter</td>
<td></td>
</tr>
<tr>
<td>Letter → 5 × 7</td>
<td></td>
</tr>
<tr>
<td>5 × 7 → Letter</td>
<td></td>
</tr>
<tr>
<td>4 × 6 → 8 × 10</td>
<td></td>
</tr>
<tr>
<td>8 × 10 → 5 × 7</td>
<td></td>
</tr>
</tbody>
</table>

16. Press the bottom right button to select the size of the paper you loaded.

<table>
<thead>
<tr>
<th>Choose this setting</th>
<th>When you’ve loaded paper this size</th>
</tr>
</thead>
<tbody>
<tr>
<td>LTR</td>
<td>Letter</td>
</tr>
<tr>
<td>4 × 6</td>
<td>4 × 6-inch</td>
</tr>
<tr>
<td>5 × 7</td>
<td>5 × 7-inch</td>
</tr>
<tr>
<td>8 × 10</td>
<td>8 × 10-inch</td>
</tr>
</tbody>
</table>

17. Press the Color button (for color copies) or B&W button (for black and white copies). Your photo or document is copied.

**Note:**
Never open the scanner lid while copying, or your copies might not look right.
To cancel a copy job in progress, press the-copy Stop button. Canceling appears on the LCD screen and your page is ejected.

**Changing the Copy Layout**

The RX500 offers you several layouts for copying.

1. Press the Menu button to display the Copy Menu on the LCD screen.

   **Note:**
   This menu is only available in Copy mode. If you don’t see Copy Menu on the screen, press the Copy button, then press the Menu button.

2. Press the OK button. You see this screen:

3. Press the bottom left button (next to Standard) to select one of the options in the table below.

4. After you choose your copy layout, press OK.

<table>
<thead>
<tr>
<th>Copy Layout setting</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Standard</strong></td>
<td></td>
</tr>
<tr>
<td>Copies your original with a standard 0.12-inch (3 mm) margin</td>
<td>![Standard Result]</td>
</tr>
<tr>
<td><strong>BorderFree</strong></td>
<td>![BorderFree Result]</td>
</tr>
<tr>
<td>Sizes your original as necessary to fit to the edges of 4 x 6-, 5 x 7-, or 8 x 10-inch paper**</td>
<td>![BorderFree Result]</td>
</tr>
<tr>
<td><strong>Min Margins</strong></td>
<td>![Min Margins Result]</td>
</tr>
<tr>
<td>Copies your original with a 0.06-inch (1.5 mm) border around the edges</td>
<td>![Min Margins Result]</td>
</tr>
<tr>
<td>Copy Layout setting</td>
<td>Result</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------</td>
</tr>
<tr>
<td><strong>Repeat</strong></td>
<td><img src="repeat.png" alt="Result" /></td>
</tr>
<tr>
<td>Prints an image multiple times on one sheet; select 4, 9, or 16 images per sheet, or Auto to print your image as many times as it will fit (prints full-size; best for photos with small margins)</td>
<td><img src="repeat.png" alt="Result" /></td>
</tr>
<tr>
<td><strong>Poster</strong></td>
<td><img src="poster.png" alt="Result" /></td>
</tr>
<tr>
<td>Prints the original image on separate sheets (4, 9, or 16) that you can paste together to make a large poster.</td>
<td><img src="poster.png" alt="Result" /></td>
</tr>
<tr>
<td><strong>2-up</strong></td>
<td><img src="2up.png" alt="Result" /></td>
</tr>
<tr>
<td>Copies two originals onto one sheet</td>
<td><img src="2up.png" alt="Result" /></td>
</tr>
<tr>
<td><strong>4-up</strong></td>
<td><img src="4up.png" alt="Result" /></td>
</tr>
<tr>
<td>Copies four originals onto one sheet</td>
<td><img src="4up.png" alt="Result" /></td>
</tr>
<tr>
<td><strong>Mirror</strong></td>
<td><img src="mirror.png" alt="Result" /></td>
</tr>
<tr>
<td>Copies a mirror image of your photo onto transfer paper so that you can iron it onto a shirt or other cloth article</td>
<td><img src="mirror.png" alt="Result" /></td>
</tr>
<tr>
<td><strong>Wallet Photo</strong></td>
<td><img src="wallet.png" alt="Result" /></td>
</tr>
<tr>
<td>Prints nine wallet-size copies of the photo on the page</td>
<td><img src="wallet.png" alt="Result" /></td>
</tr>
</tbody>
</table>

* BorderFree is only available on selected Epson photo papers.
** If you notice reduced print quality at the bottom of your copy, use the standard setting.
Making Copies Lighter or Darker

1. Press the Menu button to display Copy Menu on the LCD screen.

2. Press the bottom left button (next to Copy Layout) to choose Copy Density.

3. Press the OK button. You see this screen:

4. Press the ✈ Select button to lighten your copy, or the ◄ Select button to darken it.

5. Press the OK button to save your setting.

Saving and Reusing Copy Settings

You can save one set of custom copy settings so you can quickly reuse it for a similar copying job (for example, 5 × 7-inch photos on Premium Glossy Photo Paper). You can then “reprint” photos by pressing a single button.

1. After selecting settings, press and hold the ✈ Save button until you see Stored on the LCD screen.

2. To use your saved settings, press the ◄ Recall button until you see Recalled on the screen.

If you want to save a different group of settings, repeat step 1. This replaces your previously saved settings.
Adjusting the Copy Size Manually

You can manually adjust the size of your copies from 25% to 400%:

1. Press the **Menu** button to access the Copy Menu.
2. Press the bottom left button (next to *Copy Layout*) until you see *Optional Zoom*.
3. Press the **OK** button.
4. Use the numeric keypad to enter the percentage by which you want to enlarge or reduce your copy.
5. Press the **OK** button to save your setting.

Canceling Copies

To cancel a copy job in progress, press the **Stop** button. *Canceling* appears on the LCD screen, and the page is ejected.

Restoring Default Settings

You can reset copy settings to their original default settings. Just press and hold the **Clear/Reset** button until you see *Resetting* on the LCD screen (this takes approximately 3 seconds).
Copy With a Computer

Follow these steps to use Epson Smart Panel to copy with your computer.

**Note:**
Some features, such as PhotoEnhance™ and Sepia, are only available when copying from the computer.

1. Press the **On** button to turn on the RX500.
2. Open the scanner lid.
3. Place your photo or document face down on the glass, in the upper left corner. Move your document about 0.1 inch from the top and side edge so your entire document is scanned.

*Note:*
If you place your photo flush against the guides, the edges next to the guides may not be copied.

4. Close the scanner lid.
Note:
To copy a thick document such as a book, you can remove the scanner lid. Open the scanner lid completely. Then disconnect the cord from the TPU connector and pull the lid straight up. Turn on the RX500 and gently press down the original to keep it flat on the scanner glass as you scan. When you’re finished, be sure to turn off the RX500 before replacing the scanner lid and plugging in the connector.

5. Open the output tray.

6. Flip the feeder guard forward.

7. Pinch the sides of the left edge guide together as you slide the guide all the way to the left.

8. Insert your paper against the right edge of the sheet feeder, behind the tab.

Note:
Don’t place the paper in front of the feeder guard.
9. Press the sides of the left edge guide together and slide against the paper (but not too tightly).

10. Flip the feeder guard back over the paper.

11. Double-click the **EPSON Smart Panel** icon on your desktop to open Smart Panel.

**Note:**
You can also open Smart Panel in Windows by selecting **Start > All Programs** or **Programs > EPSON Smart Panel > EPSON Smart Panel**. On Macintosh, you can open Smart Panel from the **Applications** folder.
12. Click the Smart Panel **Copy Center** button. You see the Copy Settings screen:

![Copy Settings Screen]

**Note:**
The screens may appear slightly different on Macintosh systems.

13. Adjust any of the following copy settings:

- **Source Type:** Choose Photo & Text, Photo, or Text, based on the content of your original.
- **Reduce/Enlarge:** Choose the setting based on the size of your original and your copy, or click **Manual** and enter a percentage to reduce or enlarge your copy by a specific amount.
- **Lighten/Darken:** Adjust this by clicking the ▲ and ▼ arrows.
- **Number of Copies:** Click the ▲ and ▼ arrows to choose the number of copies.

**Note:**
Click the Copy button if you need to cancel a setting you’ve made.
14. Click the **Device Settings** button to check your input and output devices:

![Device Settings](image1.png)

You should see your **EPSON Stylus Photo RX500** as the input and output device.

15. Click **Settings** to change the displayed print settings (such as a different Media Type setting, if you loaded special paper) or select additional options. See these sections for details:

- “Printing in Windows” on page 36
- “Printing on a Macintosh” on page 43

16. Click the **Image Adjust** button to enhance your image or add effects:

![Image Adjust](image2.png)
17. Adjust any of the following settings:

- Enable or disable Automatic Document Enhancement. (This feature automatically enhances the color and appearance of your copies.)
  
  **Note:**
  Disabling the Automatic Document Enhancement feature may cause a gray or light colored background to appear on your copies.

- Add a sepia, blue, or black filter.

- Adjust brightness, contrast, or saturation levels.

18. Click the Copy button to start copying.

   If you need to stop copying in progress, click the Stop button.

**Note:**
For more information about Smart Panel copy settings, see the on-screen Smart Panel *User’s Guide* or click ? on the main Smart Panel window.
Printing From a Computer

Before you start, make sure you’ve installed your printer software as described on the Start Here sheet.

Whenever you print, make sure you do the following:

■ **Use the right paper.**
  For the best-looking photos, most vivid colors, and greatest detail, always use genuine Epson papers and ink.

■ **Choose the right printer settings.**
  Your printer automatically adjusts for each type of paper. That’s why printer settings are important. They tell your RX500 what kind of paper you’re using and what type of print you want. Make sure you check your print settings every time you print.

Follow the instructions in these sections:

■ “Printing in Windows” on page 36
■ “Customizing Windows Print Settings” on page 39
■ “Printing Photos in Windows” on page 41
■ “Printing on a Macintosh” on page 43
■ “Customizing Macintosh Print Settings” on page 49
■ “Printing Photos on a Macintosh” on page 51
■ “Selecting Your Paper Type” on page 54
Printing in Windows

After you create a document in a software program, follow these steps to print it using the basic printer settings:

1. From the File menu, click Print. You see a Print window like this one:

   ![Print window](image)

   - Check for your printer name here
   - Click here to open your printer software

2. Make sure EPSON Stylus Photo RX500 is selected.

3. Click the Preferences or Properties button.

   (If you see a Setup, Printer, or Options button, click it. Then click Preferences or Properties on the next screen.)
4. Select the following in the Printing Preferences or Properties window:

5. Select from these Quality Options:
   - Draft for rough drafts with reduced print quality
   - Text for text-only documents and higher text quality
   - Text & Image for documents with text and graphics at higher quality
   - Photo for photos and graphics with good quality and speed
   - Best Photo for photos or graphics with high print quality

   Note:
   For more information about print settings, click the ? or Help button.
   The Quality Option settings on this screen give you the best combination of quality and speed for most prints. For the highest quality (Photo RPM®) on selected papers, click the Advanced button on this screen. Then see “Customizing Windows Print Settings” on page 39 for instructions on selecting Photo RPM.

6. Select the paper Type for the paper you’ve loaded. See page 54 for guidelines.
7. Select your paper Size and image Orientation, then click OK.
8. At the Print window, click OK or Print to start printing.
During printing, this window appears and shows the progress of your print job. You can use the buttons to cancel, pause, or resume printing. You can also see how much ink you have left.

**Selecting Default Settings**

Your printer settings apply only to the program you’re currently using. If you want, you can change the Windows default printer settings for all your programs.

1. Right-click the printer icon on the Windows taskbar.
2. Select Printer Settings. You see the window shown on page 37.
3. Select the default settings you want for all your applications, then click OK.

You can still change the printer settings in your program, if necessary.
Customizing Windows Print Settings

You can use advanced settings for color matching, printing at the highest resolution available, or selecting a variety of special effects and layouts.

1. Click the Advanced button in the bottom right corner of the Main tab in the Properties window. If you see a warning message, click Continue.

2. Select the following settings as necessary:

   Select a color management method. To choose No Color Adjustment, click ICM first

   Select Paper & Quality Options as necessary

   Click here to select Photo RPM (5760 x 1440 dpi) for the best print quality on certain paper types

   Click here to select Black Ink Only printing

**Note:**
For the highest print quality, select **Photo RPM**. Note that printing will take longer. If you’re using a color management system and don’t want your printer to control the colors, choose **ICM**, then select **No Color Adjustment**.

For more information about advanced settings, or instructions for saving them as a group so you can reuse them later, click the ? or Help button. If you want to use the Advanced screen each time you access your print settings, select the **Show this screen first** checkbox.
3. Once you've finished selecting advanced settings, you can:
   ■ Click OK to save your settings, return to the Print window, and print.
   ■ Click the Basic button to return to the Basic settings.
   ■ Click the Page Layout tab and continue with step 4 to select layout options.

4. Select the following page layout settings as necessary:

   ![Page Layout Settings]

   **Note:**
   For more information on advanced and page layout settings, click the ? or Help button.

5. Click OK to save your settings and return to the Print window.
6. Click OK or Print to start printing.
Printing Photos in Windows

You can print your photos with no margins, extending the image all the way to the edges of the page. Although borderless printing is a bit slower (especially near the edges), you get beautiful snapshots or enlargements, without trimming.

<table>
<thead>
<tr>
<th>Paper name</th>
<th>Sizes</th>
<th>Paper type setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Premium Glossy Photo Paper</td>
<td>Letter (8.5 × 11 inches)</td>
<td>Premium Glossy Photo Paper</td>
</tr>
<tr>
<td></td>
<td>4 × 6 inches</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5 × 7 inches</td>
<td></td>
</tr>
<tr>
<td></td>
<td>8 × 10 inches</td>
<td></td>
</tr>
<tr>
<td>Epson Matte Paper Heavyweight</td>
<td>Letter (8.5 × 11 inches)</td>
<td>Matte Paper-Heavyweight</td>
</tr>
<tr>
<td></td>
<td>8 × 10 inches</td>
<td></td>
</tr>
<tr>
<td>Epson Glossy Photo Paper</td>
<td>Letter (8.5 × 11 inches)</td>
<td>Glossy Photo Paper</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Epson Premium Semigloss Photo Paper</td>
<td>Letter (8.5 × 11 inches)</td>
<td>Premium Semigloss Photo Paper</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Epson Premium Luster Photo Paper</td>
<td>Letter (8.5 × 11 inches)</td>
<td>Premium Luster Photo Paper</td>
</tr>
</tbody>
</table>

**Note:**
For instructions on loading special paper, see page 15, or the instructions included with the paper.

You can also print borderless photos using the LCD menus and RX500 buttons. See page 98 for details.

Follow these steps to print borderless photos using the printer software:

1. Start your software program and open your photo file.
2. Select **Print** from the File menu, then click **Properties** or **Preferences**.
3. Select Photo or Best Photo as the Quality Option setting.

4. Select one of the following paper types:
   ■ Premium Glossy Photo Paper
   ■ Matte Paper-Heavyweight
   ■ Glossy Photo Paper
   ■ Premium Semigloss Photo Paper
   ■ Premium Luster Photo Paper

5. Click the Borderless checkbox. Read the message and click OK.
   Note:
   If you need to adjust the amount of image expansion necessary for borderless printing, click the Page Layout tab and move the Expansion slider.

6. Select your paper Size setting.

7. Select Portrait or Landscape as the Orientation setting.

8. Click OK, then click OK or Print.
Printing on a Macintosh

After you create a document in a software program, follow the steps in one of these sections to print it using basic print settings:

■ For Macintosh OS X, see the next section.
■ For Macintosh OS 8.6 to 9.x, see page 47.

Printing With OS X

If you're using an OS X-compatible printing application, follow the steps below to print your document. (If you're using an application that's compatible only with Macintosh Classic mode, follow the steps on page 47 instead.)

Before you begin, make sure you installed the software and added the RX500 to Print Center or the Printer Setup Utility, as described on the Start Here poster.

1. From the File menu, select Page Setup. You see a window like this one:

   ![Page Setup window](image)

   - Select Stylus Photo RX500 from the Format for list.
   - Select your Paper Size.

   **Note:**

   When printing using a custom paper size, make sure the selected size matches the paper you loaded and is within the printable area for the printer. For example, never choose a size wider than the printer’s sheet feeder or longer than the paper. (See the on-screen Reference Guide for paper size specifications.)

2. Click OK to close the Page Setup window.
5. Select Print from the File menu. You see a window like this:

![Print settings window](image)

- Make sure your printer is selected
- Click and choose Print Settings

6. Make sure Stylus Photo RX500 is selected in the Printer list. Always make sure you select the same printer you chose in the Page Setup window.

7. Choose Print Settings from the pull-down menu. You see this window:

![Print settings window](image)

- Select the type of paper you loaded
- Select Color or Black ink
- Select higher quality or faster printing (if available)
- Select Automatic mode
8. Select the following print settings as necessary:

- **Media Type**: Select the paper type for the paper you’ve loaded. See page 54 for guidelines.
- **Color**: Select **Color** (for color documents and black and white photos) or **Black** (for black text documents).
- **Automatic**: Select this option to have the printer software automatically select the best settings for your paper type.
- **Quality/Speed**: Use the slider to choose higher quality or faster printing.
  
  **Note**: For the highest print quality (Photo RPM) on certain paper types, click **Advanced** and see the instructions for selecting Photo RPM on page 49.

  For more information about printer settings, click the **Help** button.

9. You can also choose other print settings by selecting these options in the pull-down menu:

- **Copies & Pages**: Select the number of copies you want, or a page range.
- **Layout**: Select page layout options.
- **Output Options**: Save your print job as a PDF file.
- **Color Management**: Select ColorSync® adjust the color controls, change the gamma setting, or turn off color adjustments in the printer software.

10. If you want to save your selections for future use, choose **Save As** from the Presets pop-up menu, enter a name, then click **OK**.

11. Click **Print**.

12. To monitor the progress of your print job, click the **Stylus Photo RX500** icon when it appears in the dock on the bottom of your desktop.

   If you’re using OS X 10.2, click the **Print Center** icon instead, then double-click **Stylus Photo RX500** in the Printer List window.
You see a screen like this:

```
13. Monitor the progress of your print job or do one of the following:

- Select the print job in the Status list, then click Delete to delete the job.
- Select the print job, then click Hold to pause printing.
- Select a print job marked “Hold” and click Resume to resume printing.
- If multiple print jobs are listed, select a print job, then click the Priority arrow as necessary to reorder the jobs.

14. When you're finished, close the Stylus Photo RX500 window or Print Center.
```
**Printing With OS 8.6 to 9.x**

Before you begin, make sure you've installed your software and selected the SP RX500 Series icon in the Chooser, as described on your Start Here sheet.

1. From the File menu, select Page Setup. Select the following settings:

   - **Select your paper size**
   - **Make sure you see SP RX500 Series here**
   - **Select the orientation of your photo or document**

2. Click OK to close the window.

3. From the File menu, select Print. You see this window:

   - **Select the type of paper you loaded**
   - **Select Color or Black ink**
   - **Select Automatic mode**
   - **Select higher quality or faster printing (if available)**
4. Select the following print settings as necessary:

- **Media Type**: Select the paper type you loaded; see page 54 for guidelines.
- **Color**: Select either **Color** (for color documents and black and white photos) or **Black** (for black text documents).
- **Automatic**: Select this Mode option to have the printer software automatically select the best settings for your paper type.
- **Quality/Speed**: Use the slider to choose higher quality or faster printing.

**Note:**
To select the highest print quality (Photo RPM) on selected papers, see page 50. For more information about print settings, click the ? button.

5. You can also do the following:

- Click **to reduce or enlarge your printed image, print multi-page layouts, or add a watermark.**
- Click **to control background printing and schedule print jobs.**
- Click **, then click **Preview** to preview your print job.**
- Click ** to check your ink levels.

6. **Click Print.**

7. If you turned on background printing, you can select **EPSON Monitor IV** from the Macintosh Application menu. You see this window:

**Note:**
If you’re not using background printing and you need to cancel printing, hold down the **key and press and hold the . (period) key.**
Customizing Macintosh Print Settings

You can use advanced settings to print at the highest available resolution, or adjust the print speed and layout. Follow the instructions in these sections:

- “Customizing OS X Print Settings” below
- “Customizing OS 8.6 to 9.x Print Settings” on page 50

Customizing OS X Print Settings

1. Open the Print Settings window and click Advanced.
2. Select these advanced settings as necessary:

   ![Print Settings Window]

   To select color management settings, select Color Management from this menu.

   Select various print options here.

   Click here to select Photo RPM (5760 × 1440 dpi) for the best print quality on certain paper types.

   **Note:**
   For the highest print quality, select Photo RPM. Note that printing will take longer.
   For more information on advanced settings, or instructions on saving them as a group so you can reuse them later, click Help.

3. Click Print.
Customizing OS 8.6 to 9.x Print Settings

1. Open the printer settings window, click Custom, then click the Advanced button that appears.

2. Select these advanced settings as necessary:

   - Click here to select Photo RPM (5760 × 1440 dpi) for the best print quality on selected paper types.
   - Select color management settings here.
   - Select various print options here.

   **Note:**
   For the highest print quality, select Photo RPM. Printing takes longer in this mode.
   To turn off color management in your printer software, select No Color Adjustment.
   For more information on advanced settings, or instructions on saving them as a group so you can reuse them later, click ?.

3. Click OK to save your settings, then click Print.
Printing Photos on a Macintosh

You can print your photos with no margins, extending the image all the way to the edges of the page. Although borderless printing is a bit slower (especially near the edges), you get beautiful snapshots or enlargements, without trimming.

Note:
For instructions on loading special paper, see page 15, or the instructions included with the paper.

You can also print borderless photos using the LCD menus and buttons on the RX500. See page 98 for details.

Follow the steps in these sections to print borderless photos:

■ “Printing Photos With OS X” on page 52
■ “Printing Photos With OS 8.6 to 9.x” on page 53

<table>
<thead>
<tr>
<th>Paper name</th>
<th>Sizes</th>
<th>Paper type setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Premium Glossy Photo Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>Premium Glossy Photo Paper</td>
</tr>
<tr>
<td></td>
<td>4 x 6 inches</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5 x 7 inches</td>
<td></td>
</tr>
<tr>
<td></td>
<td>8 x 10 inches</td>
<td></td>
</tr>
<tr>
<td>Epson Matte Paper Heavyweight</td>
<td>Letter (8.5 x 11 inches)</td>
<td>Matte Paper-Heavyweight</td>
</tr>
<tr>
<td></td>
<td>8 x 10 inches</td>
<td></td>
</tr>
<tr>
<td>Epson Glossy Photo Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>Glossy Photo Paper</td>
</tr>
<tr>
<td>Epson Premium Semigloss Photo Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>Premium Semigloss Photo Paper</td>
</tr>
<tr>
<td>Epson Premium Luster Photo Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>Premium Luster Photo Paper</td>
</tr>
</tbody>
</table>
Printing Photos With OS X

1. Start your application and open your photo file.
2. From the File menu, select Page Setup. You see the following window:

   ![Page Setup Window]

3. Select Stylus Photo RX500 (Sheet Feeder - Borderless) from the Format for list.

   **Note:**
   When printing borderless photos, select one of the supported paper sizes listed on page 51; never select a custom or unsupported paper size or ink may spray inside your printer.

5. Select your photo Orientation.
6. Click OK to close the Page Setup window.
7. Select Print from the File menu.
8. Select Stylus Photo RX500 (Sheet Feeder - Borderless) from the Printer list. Make sure to select this option so it matches the one you chose as the Format for setting on the Page Setup window.
9. Choose Print Settings from the pull-down menu.
10. Select one of the following paper types as the Media Type setting:

- Premium Glossy Photo Paper
- Matte Paper-Heavyweight
- Glossy Photo Paper
- Premium Semigloss Photo Paper
- Premium Luster Photo Paper

11. Click Print.

**Printing Photos With OS 8.6 to 9.x**

1. Start your application and open your photo file.

2. Select **Page Setup** from the File menu. You see the following window:

3. Click the **Borderless** checkbox.

4. Select your **Paper Size**.

   **Note:**
   When printing borderless photos, select one of the supported paper sizes listed on page 51; never select a custom or unsupported paper size or ink may spray inside your printer.

5. Select your photo **Orientation**.

6. Click **OK** to close the Page Setup window.

7. Select **Print** from the File menu. You see the Print window.
8. Select one of the following paper types as the Media Type setting:
   - Premium Glossy Photo Paper
   - Matte Paper-Heavyweight
   - Glossy Photo Paper
   - Premium Semigloss Photo Paper
   - Premium Luster Photo Paper

9. Click **Print**.

### Selecting Your Paper Type

Select the correct **Type** or **Media Type** setting in your printer software so your printer can adjust the ink correctly for your paper.

<table>
<thead>
<tr>
<th>For this paper</th>
<th>Select this setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper sheets or envelopes</td>
<td>Plain Paper</td>
</tr>
<tr>
<td>Epson Premium Bright White Paper</td>
<td>Bright White Paper</td>
</tr>
<tr>
<td>Epson Iron-On Transfer Paper</td>
<td>360 dpi Ink Jet Paper</td>
</tr>
<tr>
<td>Epson Photo Quality Ink Jet Paper</td>
<td>Photo Quality Ink Jet Paper</td>
</tr>
<tr>
<td>Epson Photo Quality Ink Jet Cards</td>
<td></td>
</tr>
<tr>
<td>Epson Photo Quality Self Adhesive Sheets</td>
<td></td>
</tr>
<tr>
<td>Epson Matte Paper Heavyweight</td>
<td>Matte Paper - Heavyweight</td>
</tr>
<tr>
<td>Epson Double-Sided Matte Paper</td>
<td></td>
</tr>
<tr>
<td>PremierArt Matte Scrapbook Photo Paper for EPSON</td>
<td></td>
</tr>
<tr>
<td>Epson Photo Paper</td>
<td>Photo Paper</td>
</tr>
<tr>
<td>Epson Glossy Photo Paper</td>
<td>Glossy Photo Paper</td>
</tr>
<tr>
<td>Epson All-Purpose Glossy Photo Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Glossy Photo Greeting Cards</td>
<td></td>
</tr>
<tr>
<td>Epson Premium Glossy Photo Paper</td>
<td>Premium Glossy Photo Paper</td>
</tr>
<tr>
<td>Epson Photo Stickers</td>
<td></td>
</tr>
<tr>
<td>Epson Premium Luster Photo Paper</td>
<td>Premium Luster Photo Paper</td>
</tr>
<tr>
<td>For this paper</td>
<td>Select this setting</td>
</tr>
<tr>
<td>---------------------------------------------------</td>
<td>-----------------------------------------</td>
</tr>
<tr>
<td>Epson Premium Semigloss Photo Paper</td>
<td>Premium Semigloss Photo Paper</td>
</tr>
<tr>
<td>EPSON ColorLife Photo Paper</td>
<td>ColorLife Photo Paper</td>
</tr>
<tr>
<td>EPSON Semigloss Scrapbook Photo Paper</td>
<td></td>
</tr>
<tr>
<td>EPSON Ink Jet Transparencies</td>
<td>Ink Jet Transparencies</td>
</tr>
<tr>
<td>EPSON Photo Stickers</td>
<td></td>
</tr>
</tbody>
</table>
Scanning to a Computer

If you would like to create digital files from printed documents, photos, or film and work with them on your computer, follow the instructions in this chapter:

- “Using Epson Smart Panel” on the next page
- “Scanning to a File” on page 60
- “Scanning From a Program” on page 63
- “Restoring Color to Old Photographs” on page 68
- “Scanning Slides and Film” on page 74
- “Scanning Using the RX500 Buttons” on page 79
Using Epson Smart Panel

Epson Smart Panel is an easy, step-by-step interface that lets you scan your photo or document, then launch a variety of programs on your computer to handle the scanned file.

1. To start Smart Panel, double-click the EPSON Smart Panel icon on your desktop. You see this screen:

2. To start one of the Smart Panel applications listed below, click its icon. Then follow the on-screen instructions to use the application.

<table>
<thead>
<tr>
<th>Smart Panel feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reprint Photos</td>
<td>Scans and prints photos in various sizes and layouts. Includes Color Restoration (restores color to old, faded photos).</td>
</tr>
<tr>
<td>Scan and Save</td>
<td>Scans a photo into Photompression, where you can edit, retouch, enhance, and print it with templates, frames, and borders. You can also use the Enhance option to correct red-eye in your digital photos (you must click on the eye in the image to apply the correction). See your Photomression on-screen Help for details.</td>
</tr>
<tr>
<td>Smart Panel feature</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Copy Center</td>
<td>Scans and prints a document with the power and flexibility of a conventional photocopier.</td>
</tr>
<tr>
<td>Copy to Fax</td>
<td>When you install your own fax software, scans your image or document to your PC fax software.</td>
</tr>
<tr>
<td>Edit Text</td>
<td>Scans text documents and converts them into editable text files on your computer (not supported for Mac® OS 8.6).</td>
</tr>
<tr>
<td>View and Create</td>
<td>Scans a photo into PhotoImpression, where you can edit, retouch, enhance, and print it with templates, frames, and borders.</td>
</tr>
<tr>
<td>Scan to Application</td>
<td>Scans a photo or document and lets you choose which program it launches for handling the scanned file.</td>
</tr>
<tr>
<td>Scan to E-mail</td>
<td>Scans a photo or document and attaches it to an e-mail so that you can send it right away.</td>
</tr>
<tr>
<td>EPSON Photo Site</td>
<td>Scans a photo and uploads it to Epson’s photo-sharing web site.</td>
</tr>
</tbody>
</table>

For details on using all the Smart Panel features, click the ? button in Smart Panel or see the on-screen Smart Panel User Guide.
Scanning to a File

Follow these steps to scan directly to a file on your computer:

1. Open the scanner lid.

2. Place your photo or document face down on the glass in the upper left corner. Move your document about 0.1 inch from the top and side edge so your entire document is scanned.

   ![Diagram of a photo being scanned with instructions]

   Move the photo in about 0.1 inch from the edges

   Orient the photo as shown

   Note:
   If you place your photo or document too close to the edges of the scanner glass, the edges of the photo or document may not be scanned.

To scan a thick document, you can remove the scanner lid. Turn off the RX500 and open the scanner lid completely. Then disconnect the cord from the TPU connector and pull the lid straight up. Turn on the RX500 and gently press down the original to keep it flat on the scanner glass as you scan. When you’re finished, be sure to turn off the RX500 before you replace the scanner lid and plug in the connector.
3. Close the scanner lid.

4. Start Epson Scan.
   
   **Windows:** Select Start > All Programs or Programs > EPSON Scan > EPSON Scan.
   
   **Macintosh:** Double-click EPSON Scan in the Applications folder.

   You see the File Save Settings window:

   ![File Save Settings window]

   5. Type a name for your file in the Prefix box.

   **Note:**
   If you don’t change the name, Epson Scan assigns the name `imgxxx`, where `xxx` is a three-digit number in a sequence (for example, `img001`, `img002`, etc.) Whether you change the name or not, all of the image files saved to your computer using Epson Scan are assigned consecutive numbers.

   6. Select a file format in the Type box.
7. Click **OK**.

Epson Scan starts and scans your file to the location specified. The default location for your scanned images is:

- **Windows XP and 2000**: C:\Documents and Settings\epson\My Documents
- **Windows Me and 98**: C:\My Documents
- **Macintosh OS X**: Users:Home:Pictures (“Home” can be any name you’ve given your computer.)
- **Macintosh OS 8.6 to 9.x**: EPSON Scan Images folder on your desktop

**Tip:**
To make scanning even more automatic, you can clear the **Show this dialog box before next scan** checkbox in the File Save Settings window. Then all you need to do to scan is place your document and start Epson Scan.
Scanning From a Program

You can scan from any TWAIN-compliant program—such as Adobe® Photoshop® or ArcSoft PhotoImpression—using Epson Scan. Epson Scan provides three scanning modes for progressive levels of control over your scanned image:

- **Full Auto Mode** makes scanning quick and easy, with automatic image type and resolution settings.

- **Home Mode** provides a simple screen giving you automatic image adjustments, previewing and cropping capability, and preset configurations for various types of scans. Includes Color Restoration.

- **Professional Mode** lets you manually configure advanced image settings, including Color Restoration. Use this mode if you have experience scanning and are familiar with color and image adjustments.

**Note:**
Epson Scan starts in the mode you used last, but you can change the mode at any time.

**Tip:**
You can restore color in your old photos. See page 68 for details.

1. Open the scanner lid.

2. Place your photo or document face down on the scanner glass, in the upper left corner. Move your document about 0.1 inch from the top and side edge so your entire document is scanned.

**Note:**
You can also place additional small documents or photos and scan them at the same time.
3. Close the scanner lid.
4. Start your application.
5. Open the File menu and choose **Import** or **Acquire**, then select EPSON Stylus Photo RX500.

6. Epson Scan starts previewing your image in Full Auto Mode. To switch modes, click the **Pause** button at the bottom of the screen.

7. Select **Home Mode** (for basic scan settings) or **Professional Mode** (for advanced scan settings) from the Mode menu at the top of the screen.
EPSON Scan previews your image and displays the screen for the mode you chose.

![Home Mode Professional Mode](image)

**Note:**
To change back to Full Auto Mode, select **Full Auto Mode** from the Mode pull-down menu at the top of the screen.

8. If you don't see an automatic preview of your scan to the right of the EPSON Scan window, click the **Preview** button.

After a moment, your image appears in the Preview window.
Note: If you placed more than one photo or document on the scanner glass, you see multiple images in the Preview window.

9. Click the Auto Detect icon to select your image, creating a movable outline called a marquee. If you’re scanning more than one image, the marquee surrounds all of them. (For information on adjusting the marquee, see page 67.)

Note: If your Home Mode preview image has a blue box around it, you’re previewing in Thumbnail mode and can’t create a marquee. Click the arrow beside the Preview button and select Normal from the menu that appears. Click the Preview button again to preview in Normal mode.

10. Choose Document Type, Image Type, and Destination settings that match the type of image you’re scanning and the way you want to print or view it. (Click Help on the Epson Scan screen for detailed information about all the available settings.)

Note: The Document Type you select determines the other options that appear in the Epson Scan window.

11. Size your image and adjust your image settings as necessary.

12. Make any other desired settings. For example, to improve the color of faded photos or negatives, click the Color Restoration box.

Note: You must preview your photo to make the Color Restoration option active.

13. Click the Scan button. Your scanned image opens in your application window.

Note: Never open the scanner lid while scanning, or your scans may not look right.

14. Click Close to exit Epson Scan.
**Adjusting the Scan Area (Marquee)**

Once you create a marquee on your preview image, you can use it to crop the area you want to scan. You can create a marquee on each preview image, if you’re scanning more than one at a time.

- To move the entire marquee, click and hold your mouse button inside the outlined area and drag the marquee to where you want it.
- To resize the marquee, click and hold your mouse button on one of the edges or corners and drag the marquee to the size you want.
- To create additional marquees on multiple images, click the next image, then click the Duplicate button. Then adjust the marquees as described above.
- To delete a marquee, click the Delete button.
- To start over with a new marquee, click the Auto Detect button.
Restoring Color to Old Photographs

You can use Epson Scan to restore color to faded photographs and open them in an application or save them to a file on your computer. If you want to restore and print one of your old photos, the easiest way is to use the Reprint Photos feature in Smart Panel (see page 73).

Placing Your Photo and Loading Paper

Follow these steps to place your photo on the scanner glass and load paper.

1. Open the scanner lid.

2. Place your photo face-down on the glass, in the upper left corner. Move your photo about 0.1 inch from the top and side edge so your entire document is scanned.

3. Close the scanner lid.

Note:
If you place your photo flush against the guides, the edges next to the guides may not be copied.
4. Open the output tray.

5. Flip the feeder guard forward.

6. Pinch the sides of the left edge guide together as you slide the guide all the way to the left.

7. Insert your paper against the right edge of the sheet feeder, behind the tab.

   **Note:**
   Don’t place the paper in front of the feeder guard.
8. Press the sides of the left edge guide together and slide against the paper (but not too tightly).

9. Flip the feeder guard back over the paper.

10. See one of the following sections to continue:
    - “Restoring and Saving Photos to Your Computer” below
    - “Restoring and Printing Photos” on page 73

**Restoring and Saving Photos to Your Computer**

Follow these steps if you want to restore color to an old photo and save the results to a file.

1. Do one of the following:
   - Windows: Select Start > All Programs or Programs > EPSON Scan > EPSON Scan
   - Macintosh: Double-click EPSON Scan in the Applications folder.
2. Epson Scan starts previewing your image in Full Auto Mode. To switch modes, click the **Pause** button at the bottom of the screen.

3. Select **Professional Mode** from the Mode menu at the top of the screen. Epson Scan previews your image and displays the Professional mode window.
4. If you don't see an automatic preview of your scan to the right of the Epson Scan window, click the Preview button.

After a moment, your image appears in the Preview window:

Note:
If you placed more than one photo on the scanner glass, you see multiple images in the Preview window.

5. Click the Auto Detect icon to select your image, creating a movable outline called a marquee. If you’re scanning more than one image, the marquee surrounds all of them. (For information on adjusting the marquee, see page 67.)

6. Choose Document Type, Image Type, and Destination settings that match the type of image you’re scanning and the way you want to print or view it. (Click Help on the Epson Scan screen for detailed information about all the available settings.)

7. Size your image and adjust your image settings as necessary.

8. Scroll down and click the Color Restoration box.

Note:
You must preview your photo to make the Color Restoration option active.

9. Click the Scan button.

Note:
Never open the scanner lid while scanning, or your scans may not look right.

10. Click Close to exit Epson Scan.
Restoring and Printing Photos

Follow these steps if you want to restore color to an old photo and then print it.

1. Double-click the EPSON Smart Panel icon on your desktop to start Smart Panel.

2. Click the Reprint Photos icon. You see this screen:

3. Make sure the EPSON Stylus Photo RX500 is selected as both your scanner and printer.
   If it isn’t, click the scanner icon or the printer icon to display a list of the scanners or printers installed on your computer. Select EPSON Stylus Photo RX500 from the list.

4. For Image Type, make sure Photo is selected. If it isn’t, click the Image Type icon to see a list of image types and select Photo.

5. Click the Print Paper icon to select your paper type and size.

6. Click the Print Size icon and select Fit to Page (Borderless) if you’ve loaded paper that supports borderless printing (see page 41 for a list of borderless papers). Otherwise, leave Fit to Page selected.

7. Click the ▲ or ▼ arrow to select the number of copies you want.
8. Click the Color Restoration button.

9. Click the Preview button to see a preview of your scan.

   **Note:**
   If you see a message that no margin is set for your paper, click OK to close it. This just reminds you that print quality declines at the edges of the paper when you select Fit to Page (Borderless) as your Print Size. You don't need to make any other settings.

10. Click Print on the preview window to begin printing.

---

### Scanning Slides and Film

You can use the film holder that came with the RX500 to scan 35 mm slides or strips of negative or positive film.

**Note:**
You can scan 35 mm color film or slides in Full Auto Mode, Home Mode, or Professional Mode using EPSON Scan. To scan black and white negative film, use Home Mode or Professional Mode.

1. Open the scanner lid and slide out the reflective mat. Set the mat aside so you can reinstall it for scanning reflective documents later.

   **Note:**
   You can’t scan film or slides unless the white reflective mat is removed from the scanner lid.
2. Remove the film holder from its storage place. (Remember to replace the film holder when you're done using it.)

3. If you're scanning slides, go to step 5.
   If you're scanning film, remove the cover from the film strip holder and slide your film strip in with the duller (emulsion) side facing up. Then replace the cover. (It should snap into place.)

   **Note:**
   If you can't tell which side is duller, look for lettering (Fuji®, Kodak®, etc.) on the side of the film. If the lettering is backward, place that side face up.
4. Position the film holder so that the film strip faces the center of the scanner glass. The positioning posts on the film holder fit in two small holes near the scanner lid, as shown. Then go to step 6.

5. If you’re scanning slides, position the film holder so that the slide section faces the center of the scanner glass. The positioning posts fit in two small holes near the scanner lid, as shown.
6. Place slides in the film holder as shown, with the duller (emulsion) side face up.

   **Note:**
   If you can’t tell which side is less shiny, look for a faint stamp on the slide mount that says “This side toward screen.” Place that side face down in the film holder.

![Position the slides in the film holder as shown, with the shiny side down](image)

7. Close the scanner lid.

8. Do one of the following:
   - Start EPSON Scan from your computer. In Windows, select **Start > All Programs** or **Programs > EPSON Scan** > **EPSON Scan**. On a Macintosh, double-click **EPSON Scan** in the Applications folder.
   - Start your TWAIN-compliant application. From the application’s File menu, choose **Import** or **Acquire**, and select **EPSON Stylus Photo RX500**.
9. If you see the screen below, you’ll need to change the scanning mode.
   ■ Click the Pause button at the bottom of the screen.
   ■ Select Home Mode or Professional Mode from the Mode pull-down menu at the top of the screen.

10. **Home Mode:** For Document Type, choose Positive Film if you’re scanning slides. Choose Color Negative Film or B&W Negative Film if you’re scanning film.
    **Professional Mode:** For Document Type, choose Film. For Film Type, select Positive Film if you’re scanning slides, or Color Negative Film or B&W Negative Film if you’re scanning film.

11. Click Preview to preview your scan.
    **Tip:**
    You must preview your scan to make some settings, like Dust Removal, active.

12. Click the Dust Removal box to reduce the appearance of dust on the film. Make any other settings you want.

13. Click Scan.
    **Note:**
    Never open the scanner lid while scanning, or your scans may not look right.

78 Scanning to a Computer
If you scanned from an application like Photoshop, your scanned images open in your application window.

**Note:**
Some applications don’t support scanning multiple images at once and will only open one scanned image.

14. Click **Close** to exit EPSON Scan.

---

**Scanning Using the RX500 Buttons**

You can use the buttons on the RX500 to scan an image to your computer or to send an e-mail with a scanned image attached.

**Note:**
Both Epson Scan and Epson Smart Panel must be installed on your computer to scan to your computer or to attach to an e-mail.

**Scanning to Your Computer**

1. Make sure the RX500 is connected to your computer.
2. Open the scanner lid.
3. Place your photo face down on the glass in the upper left corner. Move it about 0.1 inch from the top and side edge so the entire photo is scanned.

**Note:**
If you place your photo too close to the edges of the scanner glass, its edges may not be scanned.
4. Close the scanner lid.

5. Press the **Scan** button on the RX500 to switch to scan mode. You see this LCD screen:

   ![LCD screen](image)

   - Press this button until you see To PC
   - 1. To Photo Card
   - OK

6. Press the top left button to select **To PC**. Then press the **OK** button.

7. For Windows XP, if you see the screen below on your computer, select **EPSON Scan** and click the **Always use this program for this action** box. Then click **OK**.

   ![Program selection](image)

   - Select this option
   - Then select this box

8. When you see the File Save Settings window, type a name for your file in the Prefix box, select a file format in the Type box, and click **OK**.

   Epson Scan starts and scans your image to the location you specified.
Scanning to E-Mail

This section explains how to use the buttons on the RX500 to scan an image, transfer it to your e-mail program, and attach it to an e-mail.

**Note:**
You can also scan to e-mail by double-clicking the EPSON Smart Panel icon on your desktop and clicking the Scan to E-mail icon. See Smart Panel Help for details.

1. Make sure the RX500 is connected to your computer.
2. Open the scanner lid.
3. Place your photo face down on the glass in the upper left corner. Move it about 0.1 inch from the top and side edge so the entire photo is scanned.

   **Note:**
   If you place your photo too close to the edges of the scanner glass, the edges may not be scanned.

4. Close the scanner lid.
5. Press the Scan button on the RX500 to switch to scan mode. You see this LCD screen:

6. Press the top left button to select To E-mail. Then press the OK button.
7. If you see a screen asking you to choose a program to launch this action, select EPSON Smart Panel and click the Always use this program box. Then click OK.

The Epson Smart Panel window appears. Epson Scan automatically previews and scans the image, which opens in the View Images and Set Options window.

**Note:**
If you've switched to Home or Professional mode in Epson Scan, previewing and scanning is not automatic. Click Preview, then click Scan.

8. Select any settings you want to change, then click Next.

The scanned image is transferred to your e-mail program and attached to a new e-mail message.

**Note:**
If you see a window asking you to select the program to launch for this action, select your e-mail program and click OK. See Smart Panel Help for details.
Using Memory Cards

This section tells you what kinds of memory cards you can use with your RX500, and how to view and print photos on them and scan photos to them. See these sections:

■ “Compatible Memory Cards” below
■ “Inserting and Removing Cards” on page 84
■ “Copying Photos to Your Computer” on page 85
■ “Printing From a Memory Card” on page 89
■ “Scanning a Photo to a Memory Card” on page 105

Compatible Memory Cards

You can use the following types of cards with your RX500:

CompactFlash Type I and Type II  SmartMedia (maximum 128MB)
SD (Secure Digital) Card  Memory Stick
MMC (MultiMediaCard)  Memory Stick PRO
miniSD Card (adapter required)  MagicGate Memory Stick
xD-Picture Card  Memory Stick Duo (adapter required)
Microdrive

Make sure the image files on your card meet these requirements:

■ JPEG files or uncompressed Tiff files only
■ Resolutions ranging from 120 × 120 to 4600 × 4600 pixels
■ No more than 999 images (although you may have additional images on your card, the RX500 can only read the first 999)
Inserting and Removing Cards

1. Make sure the RX500 is turned on.

2. If you will be printing from or scanning to the memory card, disconnect the RX500 from your computer or turn off your computer.

   If you want to copy images between the card and your computer, leave the computer connected. Any photos stored on the card can be automatically copied to your computer when you insert the card (see “Copying Photos to Your Computer” on page 85).

3. Open the memory card cover.

4. Make sure the memory card light (next to the memory card slots) is off and that no cards are in any of the slots. Then insert a card into the correct slot, as shown below.

   Note:
   It won’t be possible to insert the card fully; this is normal.
The memory card light flashes, then turns green.

**Caution:**
Do not insert more than one card into a shared memory card slot.

After the RX500 reads the card, you see this message on the LCD screen if it finds any images:

5. Press the bottom right button to choose OK.

To remove the card, pull it straight out of its slot. On a Macintosh, drag the card icon on your desktop to the icon before removing the card.

---

**Copying Photos to Your Computer**

You can use your RX500 as an external card reader, letting you copy images from the memory card to your computer, or vice versa.

You can set up your computer so that every time you insert a memory card, it automatically copies all images from the card to a specific location on your hard drive and opens Photolmpression or another photo-editing application, such as Photoshop®. If you don’t want to do this, you can set it up so that nothing happens when you insert a card. Since the memory card appears as a removable hard drive (EPSON_DSC) on your computer, you can still copy images to or from this icon.

**Note:**
If you want to copy images to the memory card, make sure the card’s write-protect tab, if it has one, is set to allow writing to the card.
If the RX500 is connected to the computer, you'll see the following message on your screen the first time you insert a memory card:

![Memory card cover](image)

This means you have to set up your computer to use the card reader feature. Follow the instructions below for your operating system.

**Windows and OS 8.6 to 9.x**

1. Make sure your RX500 is turned on and connected to your computer.
2. Open the memory card cover.
3. Make sure the memory card light (next to the memory card slots) is off and that no cards are in any of the slots. Then insert a card into the correct slot (see page 84 to identify the slot you need).

   **Note:**
   It won’t be possible to insert the card fully; this is normal.

4. If you see a screen asking you to choose a program to launch this action, select **Startup CardMonitor**, click the checkbox for **Always do the selected action**, and click **OK**.
5. When you see this message, click **Next**:
6. The Epson PhotoStarter setup assistant opens. Follow the instructions on the screen to change any settings from the defaults and complete the setup steps.

   If you don’t change any settings, PhotoStarter automatically copies the images on your memory card to your hard drive and opens PhotoImpression.
The default location for your images is C:\Documents and Settings\epson\My Documents\Photos (Windows XP) or the Photos folder on your desktop for all other Windows systems and Macintosh OS 8.6 to 9.x.

Each time you insert a card in the RX500, PhotoStarter copies your images to the same location, and PhotoImpression or the application you chose in the setup process opens. If you chose not to copy images automatically to your computer, you can access the memory card’s drive icon, EPSON_DSC, on your computer.

**Note:**
If you see an error message at the end of setup, make sure you have the latest Service Pack software. For Windows 2000, make sure Service Pack 4.x is installed.

**Macintosh OS X**

1. Open the Applications folder on your hard drive, then double-click ImageCapture. You see this screen:

2. From the Image Capture menu, select Preferences. You see this screen:

3. From the Camera Preferences drop-down list, select Other. A new Applications folder opens.

4. Open the EPSON CardMonitor folder, then click the EPSON CardMonitor icon.
5. Click the Open button. Then close the Image Capture utility.

6. Make sure your RX500 is turned on and connected to your Macintosh.

7. Open the memory card cover:

8. Make sure the memory card light (next to the memory card slots) is off and that no cards are in any of the slots. Then insert a card into the correct slot (see page 84 to identify the slot you need).

   **Note:**
   It won't be possible to insert the card fully; this is normal.

9. The Epson PhotoStarter setup assistant opens. Follow the instructions on the screen to change any settings from the defaults and complete the setup steps.

   If you don't change any settings in the setup assistant, PhotoStarter automatically copies the images on your memory card to the Photos folder on your desktop and opens PhotoImpression. Each time you insert a card in the RX500, PhotoStarter copies your images to the same location, and PhotoImpression or the application you chose in the setup process opens. If you chose not to copy images automatically to your Macintosh, you can still copy images to and from the EPSON_DSC icon on your desktop.
Printing From a Memory Card

The RX500 lets you print photos directly from your digital camera’s memory card—you don’t even have to connect it to a computer. Follow the instructions in this section to:

- Print an index form so that you can see thumbnail images of all the photos on your card; see below
- Select the photos you want to print, either by filling in and scanning the index form or using the RX500 buttons; see page 92
- Print photos pre-selected on a digital camera that supports DPOF (Digital Print Image Format); see page 94
- Use the RX500 buttons to choose print settings; see page 96

Printing an Index Form

You need to print an index form before printing any photos from your memory card. An index form lets you see small thumbnail images of the pictures on your card and select the ones you want to print.

1. Open the output tray.

2. Flip the feeder guard forward.
3. Pinch the sides of the left edge guide together as you slide the guide all the way to the left.

4. Insert several sheets of plain, letter-size paper against the right edge of the sheet feeder, behind the tab. (If there are more than 36 images on the card, you need multiple sheets to print the index.)

   **Note:**
   Don’t place the paper in front of the feeder guard.

5. Press the sides of the left edge guide together and slide against the paper (but not too tightly).

6. Flip the feeder guard back over the paper.
7. Disconnect the RX500 from your computer or turn your computer off. Otherwise, photos on your card will be automatically copied to your computer if you've set up your RX500 as an external card reader (see page 85).

8. Open the memory card cover:

9. Make sure the memory card light (next to the memory card slots) is off and that no cards are in any of the slots. Then insert a card into the correct slot (see page 84 to identify the slot you need).

   **Note:**
   It won’t be possible to insert the card fully; this is normal.

   The memory card light flashes, then turns green.

   **Caution:**
   Do not insert more than one card into a shared memory card slot.

   After the RX500 reads the card, you see this message on the LCD screen if it finds any images:

10. Press the **Memory Card** button on the control panel to enter memory card mode. **Print Index** appears on the LCD screen.

11. Press the **OK** button.

12. Press the **Color** button to print the index. After the index form prints, **Scan Index** appears on the LCD screen.

13. Leave your memory card in the memory card slot so that you can print from it. Continue with the next section.
Selecting Photos To Print

You can select the photos you want to print either by filling in the ovals on the index form and scanning the form (as described below), or by selecting a photo or range of photos from the control panel (as described on page 93).

Selecting Photos on the Index Form

1. Once you have printed the index form, fill in the oval beneath each photo you want to print with a dark pen or pencil.

   Correct: 

   Incorrect: 

2. Near the bottom of the form, select the type and size of paper you want to use. You can select from these options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Available paper types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prem. Glossy - 4 × 6</td>
<td>Epson Premium Glossy Photo Paper</td>
</tr>
<tr>
<td>Prem. Glossy - Letter</td>
<td>Epson Premium Semigloss Photo Paper</td>
</tr>
<tr>
<td>Prem. Glossy - 8 × 10</td>
<td></td>
</tr>
<tr>
<td>Glossy - Letter</td>
<td>Epson Photo Paper</td>
</tr>
<tr>
<td>Glossy - 4 × 6</td>
<td>Epson Glossy Photo Paper</td>
</tr>
<tr>
<td>Matte - Letter</td>
<td>Epson Matte Paper Heavyweight Epson Double-Sided Matte Paper</td>
</tr>
</tbody>
</table>

3. Load the type of paper you’ve chosen to print on. Insert it against the right edge guide beneath the tab, and slide the left edge guide lightly against it.

   Note: Remember to load the paper short edge first and printable (whiter or brighter) side up.
4. Make sure Scan Index appears on the LCD screen, then press OK. (If it doesn’t appear, press the Memory Card button, then press the top left button on the LCD screen until you see Scan Index and press OK.)

5. Place the index form face down in the upper left corner of the scanner glass, about 0.1 inch from the edges.

6. Close the scanner lid.

7. Press the Color button. The form is scanned and your photos are automatically printed.

**Selecting Photos Using the Buttons on the RX500**

1. Once you’ve printed the index form, identify a photo or range of consecutive photos you want to print.

2. Load the type of paper you want to print on. Insert it against the right edge guide beneath the tab, and slide the left edge guide lightly against it.

   **Note:**
   Remember to load the paper short edge first and printable (whiter or brighter) side up.

3. Make sure you’re in memory card mode (if necessary, press the Memory Card button).
4. Press the top left button next to the LCD screen to select **One image**, **Range of Images**, or **All images**, then press the **OK** button.

5. If you want to print one image or a range of images, follow the instructions on the LCD screen and use the number keypad to select the images you want to print. Then press the **OK** button.

6. Enter the number of copies of each photo you want to print (up to 99), then press the **OK** button.

7. Change any print settings, as needed. You can select the paper type, paper size, and layout. See page 96 for details.

8. Press the **Color** button. Your photos are printed.

**Printing With DPOF**

If your memory card contains photos taken with a camera that supports DPOF (Digital Print Order Format), you can pre-select the photos you want to print while the card is still in the camera. See your camera’s documentation for instructions on selecting photos.

Follow these steps to print the photos from your card:

1. Open the memory card cover:

2. Make sure the memory card light (next to the memory card slots) is off and that no cards are in any of the slots. Then insert a card into the correct slot (see page 84 to identify the slot you need).
Note:
It won’t be possible to insert the card fully; this is normal.

The memory card light flashes, then turns green.

Caution:
Do not insert more than one card into a shared memory card slot.

After the RX500 reads the card, you see this message on the LCD screen if it finds any images:

3. Load the type of paper you want to print on. Insert it against the right edge guide beneath the tab, and slide the left edge guide lightly against it.

Note:
Remember to load the paper short edge first and printable (whiter or brighter) side up.

4. Press the Memory Card button to enter memory card mode.

5. Using the number keypad, enter the number of copies of each photo you want to print (up to 99), and press OK.

Note:
The number of copies is how many times each photo prints, not the number of pages. For example, if you’re using a layout that fits 8 photos and you select 3 copies, you will get one sheet with 3 photos printed on it.
6. Change any print settings, as needed. You can select the paper type, paper size, and layout. See the next section for details.

7. Press the Color button. Your photos are printed.

**Choosing Print Settings**

Before printing your photos, you may need to adjust some of these settings.

**Note:**
If you need to cancel any of the print settings you select in memory card mode, you can’t use the Clear/Reset button. Instead press the Copy button to switch to copy mode. Then press the Memory Card button and select your settings again.

**Paper Type**

If you’ve loaded special paper, use this button to select one of the paper type settings listed in the table below:

<table>
<thead>
<tr>
<th>For this paper</th>
<th>Select this setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>Plain</td>
</tr>
<tr>
<td>Epson Premium Bright White Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Photo Quality Ink Jet Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Photo Quality Ink Jet Cards</td>
<td></td>
</tr>
<tr>
<td>Epson Photo Quality Self-Adhesive Sheets</td>
<td></td>
</tr>
<tr>
<td>Epson Photo Paper</td>
<td>Glossy</td>
</tr>
<tr>
<td>Epson Glossy Photo Paper</td>
<td>Glossy</td>
</tr>
<tr>
<td>Epson All-Purpose Glossy Paper</td>
<td>Glossy</td>
</tr>
<tr>
<td>Epson Glossy Photo Greeting Cards</td>
<td>Glossy</td>
</tr>
<tr>
<td>Epson Premium Glossy Photo Paper</td>
<td>Prem. Glossy</td>
</tr>
<tr>
<td>Epson Photo Stickers</td>
<td>Prem. Glossy</td>
</tr>
<tr>
<td>Epson Premium Semigloss Photo Paper</td>
<td>SemiGloss</td>
</tr>
<tr>
<td>Epson Semigloss Scrapbook Photo Paper</td>
<td>SemiGloss</td>
</tr>
<tr>
<td>Epson Premium Luster Photo Paper</td>
<td>Prem. Luster</td>
</tr>
<tr>
<td>Epson Premium Luster Photo Paper</td>
<td>Prem. Luster</td>
</tr>
</tbody>
</table>
Paper Size

Use this button to select the size of paper you’ve loaded. Choose one of these sizes: LTR (letter), 4 × 6, 5 × 7, 8 × 10. (Some sizes are not available, depending on the selected paper type.)

Note:
The 4 × 6 paper size option is not compatible with Glossy Photo Paper, 4 × 6 inches, with micro-perforated edges (S041134 and S051671).

<table>
<thead>
<tr>
<th>For this paper</th>
<th>Select this setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Matte Paper Heavyweight</td>
<td>Matte</td>
</tr>
<tr>
<td>Epson Double-Sided Matte Paper</td>
<td></td>
</tr>
<tr>
<td>Premier Art Matte Scrapbook Paper for EPSON</td>
<td></td>
</tr>
<tr>
<td>Epson ColorLife Photo Paper</td>
<td>ColorLife</td>
</tr>
</tbody>
</table>

Printing From a Memory Card  97
**Layout**

Use this button to select one of these layout settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>B-Free</td>
<td>Prints without margins so that the image covers the whole page.</td>
</tr>
<tr>
<td>1-up 2-up 4-up 8-up 20-up 80-up</td>
<td>Prints one or more photos per page. For example, 8-up prints up to 8 photos per page. If you selected one photo to print, the actual number of photos on your page depends on the number of copies you selected. For example, if you selected 8-up for your layout and 5 copies, 5 photos will print on your page. If you selected a range of photos to print, the number of photos on your page depends on the range and layout you selected. For example, if you selected 8-up for your layout and selected a range of 6 photos, 6 different photos will print on your page. More than one sheet may be needed to print your range of photos. The size of each photo is adjusted automatically for layout and paper size.</td>
</tr>
<tr>
<td>Upper 1/2</td>
<td>Prints only on the upper half of each sheet.</td>
</tr>
</tbody>
</table>
Resolution

1. Press the Menu button. You see this screen:

2. Press OK. Then press the bottom left button (next to Resolution) to choose from these settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Best</td>
<td>Prints at 1440 × 720 dpi</td>
</tr>
<tr>
<td>Photo</td>
<td>Prints at 720 × 720 dpi</td>
</tr>
</tbody>
</table>

Color Effect

1. Press the Menu button, then press the bottom left button (next to Resolution) until you see Color Effect on the screen.

2. Press OK. Then press the bottom left button to choose from these settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color</td>
<td>Prints in color or grayscale</td>
</tr>
<tr>
<td>Sepia</td>
<td>Prints with a sepia tone</td>
</tr>
</tbody>
</table>

Auto Correct

1. Press the Menu button, then press the bottom left button (next to Resolution) until you see Auto Correct on the screen.
2. Press OK. Then press the bottom left button to choose from these settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Uses no automatic correction</td>
</tr>
<tr>
<td>P.I.M.</td>
<td>Prints using PRINT Image Matching information for improved image quality (your digital camera must support PRINT Image Matching)</td>
</tr>
<tr>
<td>Exif</td>
<td>Prints using Exif Print information for improved image quality (your digital camera must support Exif Print)</td>
</tr>
<tr>
<td>Auto Photo Fine</td>
<td>Prints enhanced images; printing takes longer, but print quality is better than images printed without correction</td>
</tr>
</tbody>
</table>

**Enhance Resolution**

If you are printing low-resolution images, or images that contain digital noise, use this setting.

1. Press the **Menu** button, then press the bottom left button (next to **Resolution**) until you see **Enhance Res.** on the screen.

2. Press OK. Then press the bottom left button to choose from these settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Removes digital noise in photos and enhances the resolution of low-resolution images</td>
</tr>
<tr>
<td>Off</td>
<td>Does not remove digital noise or enhance resolution</td>
</tr>
</tbody>
</table>
**Brightness**

1. Press the **Menu** button, then press the bottom left button (next to Resolution) until you see **Brightness** on the screen.
2. Press **OK**. Then press the bottom left button to choose from these settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard</td>
<td>Does not adjust brightness</td>
</tr>
<tr>
<td>Brighter</td>
<td>Makes printouts slightly brighter</td>
</tr>
<tr>
<td>Brightest</td>
<td>Makes printouts very bright</td>
</tr>
<tr>
<td>Darkest</td>
<td>Makes printouts very dark</td>
</tr>
<tr>
<td>Darker</td>
<td>Makes printouts slightly darker</td>
</tr>
</tbody>
</table>

**Contrast**

1. Press the **Menu** button, then press the bottom left button (next to Resolution) until you see **Contrast** on the screen.
2. Press **OK**. Then press the bottom left button to choose from these settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Makes no contrast adjustment</td>
</tr>
<tr>
<td>Hi</td>
<td>Prints with slightly enhanced contrast</td>
</tr>
<tr>
<td>Super Hi</td>
<td>Prints with very high contrast</td>
</tr>
</tbody>
</table>
**Sharpness**

1. Press the **Menu** button, then press the bottom left button (next to **Resolution**) until you see **Sharpness** on the screen.

2. Press **OK**. Then press the bottom left button to choose from these settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard</td>
<td>Makes no sharpness adjustment</td>
</tr>
<tr>
<td>Sharper</td>
<td>Makes the outline of objects slightly sharper</td>
</tr>
<tr>
<td>Sharpest</td>
<td>Makes the outline of objects very sharp</td>
</tr>
<tr>
<td>Softest</td>
<td>Makes the outline of objects very soft</td>
</tr>
<tr>
<td>Softer</td>
<td>Makes the outline of objects slightly softer</td>
</tr>
</tbody>
</table>

**Saturation**

1. Press the **Menu** button, then press the bottom left button (next to **Resolution**) until you see **Saturation** on the screen.

2. Press **OK**. Then press the bottom left button to choose from these settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard</td>
<td>Makes no saturation adjustment</td>
</tr>
<tr>
<td>More</td>
<td>High color saturation; makes printouts slightly more vivid</td>
</tr>
<tr>
<td>Most</td>
<td>Highest color saturation; makes printouts very vivid</td>
</tr>
<tr>
<td>Least</td>
<td>Low color saturation; makes printouts very dull</td>
</tr>
<tr>
<td>Less</td>
<td>Lower color saturation; makes printouts slightly less vivid</td>
</tr>
</tbody>
</table>
**Date**

1. Press the **Menu** button, then press the bottom left button (next to **Resolution**) until you see **Date** on the screen.

2. Press **OK**. Then press the bottom left button to choose from these settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Prints with no date information</td>
</tr>
<tr>
<td>yyyy.mm.dd</td>
<td>Prints a date in the following format: 2004.09.08 (when the date is September 8, 2004)</td>
</tr>
<tr>
<td>mm.dd.yyyy</td>
<td>Prints a date in the following format: 09.08.2004 (when the date is September 8, 2004)</td>
</tr>
<tr>
<td>dd.mm.yyyy</td>
<td>Prints a date in the following format: 08.09.2004 (when the date is September 8, 2004)</td>
</tr>
</tbody>
</table>

**Time**

1. Press the **Menu** button, then press the bottom left button (next to **Resolution**) until you see **Time** on the screen.

2. Press **OK**. Then press the bottom left button to choose from these settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Prints with no time information</td>
</tr>
<tr>
<td>12-hour system</td>
<td>Prints the time using the 12-hour system (for example, 11:00)</td>
</tr>
<tr>
<td>24-hour system</td>
<td>Prints the time using the 24-hour system (for example, 22:00)</td>
</tr>
</tbody>
</table>
Print Information

By turning this function on, you can print information about each of your digital images, such as exposure time, shutter speed, F number, and ISO rate. You can only print this information if your images comply with the Exif standard.

1. Press the Menu button, then press the bottom left button (next to Resolution) until you see Print Info on the screen.

2. Press OK. Then press the bottom left button to choose from these settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Prints with no print information</td>
</tr>
<tr>
<td>On</td>
<td>Print information appears in the bottom right corner of the printout</td>
</tr>
</tbody>
</table>

Fit to Frame

1. Press the Menu button, then press the bottom left button (next to Resolution) until you see Fit to Frame on the screen.

2. Press OK. Then press the bottom left button to choose from these settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Automatically trims your image to fit the print size selected</td>
</tr>
<tr>
<td>Off</td>
<td>Does not trim the image</td>
</tr>
</tbody>
</table>
**Hi Speed**

This setting allows you to perform bidirectional printing for greater speed.

1. Press the Menu button, then press the bottom left button (next to Resolution) until you see Hi Speed on the screen.

2. Press OK. Then press the bottom left button to choose from these settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Increases print speed by enabling bidirectional printing</td>
</tr>
<tr>
<td>Off</td>
<td>Bidirectional printing is not enabled, so printing is slower</td>
</tr>
</tbody>
</table>

---

**Scanning a Photo to a Memory Card**

Follow these steps to scan an image to a memory card and save it in JPEG format:

1. Make sure your RX500 is not connected to your computer or your computer is turned off.

2. Open the memory card cover:

3. Make sure the memory card light (next to the memory card slots) is off and that no cards are in any of the slots. Then insert a card into the correct slot (see page 84 to identify the slot you need).

**Note:**

It won’t be possible to insert the card fully; this is normal.
The memory card light flashes, then turns green.

**Caution:**
Do not insert more than one card into a shared memory card slot.

**Note:**
If the card is not properly formatted, you see a message on the LCD screen. Press the button indicated on the screen to format the card. Any data stored on the card will be erased.

4. Open the scanner lid.
5. Place your photo face down on the glass in the upper left corner. Move your photo about 0.1 inch from the top and side edge so the entire photo is scanned.

6. Close the scanner lid.
7. Press the **Scan** button to enter scan mode.
   
   You see an LCD screen similar to the one to the right. If necessary, press the upper left button until **To Photo Card** appears.

8. Press the **OK** button.

   **Note:**
   You can also scan to your computer or create an e-mail with the scanned image attached. See the instructions beginning on page 79.
9. Use the buttons next to the LCD screen to select the following options:

- **Graphic** for the document type
- **Photo** for the image quality
- **Auto** for the scan area; if the edges of the photo are light in color, select **Max.** for the scan area

10. Press the **OK** button. You see a message on the LCD screen instructing you to place your original on the scanner glass and press the **Color** button.

11. Press the **Color** button. The photo is scanned to the **epscan** folder on your memory card. Wait for scanning to finish, then remove the card.

**Caution:**
Never open the scanner unit while scanning or copying, or you could damage the RX500.
Using Memory Cards
Maintaining the RX500

If you notice a decline in print quality, follow the instructions in this chapter to check and clean the print head. You’ll also find instructions on checking ink levels and replacing ink cartridges, aligning the print head, and transporting the RX500.

See these sections:
- “Cleaning the Print Head” below
- “Replacing Ink Cartridges” on page 111
- “Aligning the Print Head” on page 115
- “Transporting the RX500” on page 118

Cleaning the Print Head

If your printouts are unexpectedly light, or dots or lines are missing, you may need to clean the print head. This unclogs the nozzles so they can deliver ink properly. Print head cleaning uses ink, so clean it only if quality declines.

Note:
You can also use a printer software utility to clean the print head right from your computer. Select the ? or Help button on your printer settings window for instructions on running the print head cleaning utility.

1. Make sure the RX500 is turned on but not printing, and the ! error light is off. (If the ! error light is flashing or on, you may need to replace an ink cartridge; see page 111 for details.)

2. Press the Setup button to enter setup mode. You see an LCD screen similar to this:
3. Press the top left button (next to Ink levels) until you see this on the LCD screen:

4. Press the  Color button.

Cleaning takes about 30 seconds, during which Head Cleaning appears on the LCD screen.

**Caution:**
Never turn off the RX500 while Head Cleaning appears on the LCD screen, unless it hasn’t moved or made noise for more than 5 minutes.

5. When you again see the LCD screen shown on the right, run a nozzle check to confirm the print head nozzles are clean.

Make sure letter-size paper is loaded (see page 13 for instructions). Press the top left button until you see Nozzle Check on the LCD screen, then press the  Color button. The nozzle check pattern prints.

**Note:**
You can also use a printer software utility to print a nozzle check right from your computer. Select the ? or Help button on your printer settings window for instructions on running the nozzle check utility.

6. Examine the nozzle check pattern you print. It should look like this:

Each line should be complete, with no gaps in the dot pattern. If your printout looks okay, you’re done.

If you see any gaps in the dot pattern, clean the print head again.

If you don’t see any improvement after cleaning three or four times, check the solutions beginning on page 121. You can also turn the RX500 off and wait overnight—this allows any dried ink to soften—and then try cleaning the print head again.

**Caution:**
When you don’t turn on your RX500 for a long time, the print quality can decline. It’s a good idea to turn it on at least once a month to maintain good print quality.
Replacing Ink Cartridges

To check ink levels, follow these steps:

1. Press the Setup button to enter setup mode.

2. If necessary, press the upper left button next to the LCD screen until Ink Levels is displayed, then press the Color button.

   You see the amount of ink available in each cartridge: C (Cyan), M (Magenta), Y (Yellow), K (Black), LC (Light Cyan), and LM (Light Magenta).

   **Tip:**
   To view all the ink levels, wait for them to scroll across the screen.

3. When done, press the OK button.

When your ink starts getting low, make sure you have replacement cartridges available. You can't print if a cartridge is empty.

**Installing New Cartridges**

Make sure you have a new ink cartridge before you begin. Once you start replacing an ink cartridge, you must complete all the steps in one session. Use these cartridges:

<table>
<thead>
<tr>
<th>Color</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black</td>
<td>T048120</td>
</tr>
<tr>
<td>Cyan</td>
<td>T048220</td>
</tr>
<tr>
<td>Magenta</td>
<td>T048320</td>
</tr>
<tr>
<td>Yellow</td>
<td>T048420</td>
</tr>
<tr>
<td>Light Cyan</td>
<td>T048520</td>
</tr>
<tr>
<td>Light Magenta</td>
<td>T048620</td>
</tr>
</tbody>
</table>
When you need new ink cartridges, contact your dealer. You can also call the Epson Store℠ at (800) 873-7766 or visit www.epsonstore.com (U.S. sales only). In Canada, please call (800) 463-7766 for dealer referral.

Caution:
To ensure good results, use genuine Epson ink cartridges and do not refill them. Other products may cause damage to your RX500 not covered by Epson's warranty.

You can’t print if an ink cartridge is empty. Leave the empty cartridge installed in the RX500 until you have a replacement. Otherwise the ink remaining in the print head nozzles may dry out.

Warning:
Keep ink cartridges out of the reach of children. If ink gets on your hands, wash them thoroughly with soap and water. If ink gets in your eyes, flush them thoroughly with water.

Follow these steps to replace an ink cartridge:

1. **If an ink cartridge is empty:**
   Look at the LCD screen to see which cartridge is empty, then press the Color button.

   **If an ink cartridge is low:**
   Press the Setup button to enter setup mode, then press the upper left button next to the LCD screen until Replace Ink is displayed. Then press the Color button.

2. **When you see Open the scanner on the LCD screen**, use the side grips to open the scanner unit, as shown, making sure to keep the scanner lid closed on top.
3. Wait for the ink cartridge holder to move to the replacement position on the far right, then open its cover by pulling it back up and toward you.

   **Caution:**
   Never attempt to open the cartridge holder's cover while the print head is moving. Wait until the cartridges have moved to the replacement position.

4. Identify the cartridge you need to replace. Press in the tab at the back of the cartridge to release it, then lift the cartridge straight out. Dispose of it carefully.

   **Note:**
   The illustration above shows the black ink cartridge being removed. Only remove the cartridge(s) you need to replace.

5. Unwrap the new cartridge.

   **Caution:**
   Don't remove any labels or seals from the cartridge.
6. Insert the new cartridge into the holder. Press down firmly until it clicks into place.

If you need to replace other ink cartridges, repeat steps 4 through 6 before continuing with step 7.

7. Close the cartridge cover. (It should click into place.)

**Caution:**
If you find it difficult to close the cover, make sure all the cartridges are firmly seated. Press down on each newly installed cartridge until you hear it click into place. Do not attempt to force the cover closed.

8. Lower the scanner unit.

The RX500 begins charging the ink delivery system and **Charging** appears on the LCD screen. Wait for the message to disappear before using the RX500.

**Caution:**
Never turn off the RX500 while **Charging** appears on the LCD screen, unless it hasn’t moved or made noise for more than 5 minutes. This may cause incomplete charging of the ink.

**Note:**
Ink charging uses ink, so it’s best to install new ink cartridges or used cartridges with a relatively high level of ink. Used cartridges with little ink remaining may become empty immediately after being installed.
Aligning the Print Head

If your printouts look grainy or vertical lines appear jagged, you may need to align the print head.

**Note:**
You can also use the buttons on the RX500 to align the print head (see the on-screen Reference Guide for instructions). For best results, we recommend you use the print head alignment utility, as described in this section.

1. Make sure the RX500 is turned on and not printing, and the ! error light is off.
2. Load several sheets of plain letter-size paper (see page 13 for instructions).
3. Do one of the following:
   - **Windows:** Right-click the icon on the Windows taskbar and click Print Head Alignment.
   - **Macintosh OS X:** Double-click EPSON Printer Utility in your Applications folder. Select SP RX500 Series in the Printer List and click OK. Then click the Print Head Alignment button.
   - **Macintosh OS 8.6 to 9.x:** From your application's File menu, choose Page Setup or Print. Click the button in the printer settings or page setup dialog box. Then click the Print Head Alignment button.
4. Follow the on-screen instructions to print the black vertical alignment pattern. Your printout should something look like this:

5. Examine the printout and choose the best square in each of the four sets. (The best square should have no visible bands, or the least visible bands.)
6. In the on-screen window, select the number for each of these squares in the corresponding pull-down menu.

![Print Head Alignment](image)

**Note:**
This procedure shows OS X screens. Screens for other operating systems will look similar.

7. If the best square in each set is number 5, click **Next**. Otherwise, click **Realignment** and follow the on-screen instructions to print a new black vertical alignment pattern. Repeat this step until the best square for each set is number 5.

8. Follow the on-screen instructions to print a color vertical alignment pattern. Repeat steps 5 through 7 to correct color vertical alignment.

9. When you're done, click **Finish**.
Transporting the RX500

If you move your RX500 some distance, you need to prepare it for transportation in its original box or one of a similar size.

**Caution:**
To avoid damage, always leave the ink cartridges installed when transporting the RX500. Never transport or store the printer on its side or in a tilted or upside-down position.

1. Press the 
   On button to turn on the RX500. Wait until the scanner carriage moves to the home position (toward the left side) and the print head locks in the far right position. Then turn off the RX500.

2. Open the scanner lid and slide the transportation lock to the \( \text{\textbullet}\) locked position. Close the scanner lid.

3. Unplug the power cord from the electrical outlet. Then disconnect the USB cable from your computer.

4. Disconnect the TPU cable from the TPU connector on the back of the RX500.

5. Remove any paper from the sheet feeder and output tray, then remove the paper support and feeder guard.

6. Close the output tray.

7. Lift up the scanner unit.
8. Remove the orange print head holder from its storage area and install it as shown to prevent the print head from moving during transport. If you can’t find the orange print head holder, tape the print head to the case.

Caution:
Be sure to remove the print head holder or the tape after installing the RX500 in its new location.

9. Lower the scanner unit carefully until it clicks back into place.

10. Repack the RX500 and its attachments in the original box using the protective materials that came with them.

Caution:
Keep the RX500 level as you transport it.

After transporting the RX500, remove the print head holder or tape securing the print head, unlock the transportation lock, and make a test copy. If you notice a decline in quality, clean the print head (see page 109); if output is misaligned, align the print head (see page 115).
Solving Problems

If you have a problem with the RX500, check the messages on the LCD screen, run a nozzle check (see page 109), or see “Problems and Solutions” below. For problems with scanning or printing from your computer, or with uninstalling the software, double-click the *SP RX500 Reference Guide* icon on your computer desktop.

If none of the solutions solve your problem, see “Where To Get Help” on page 123.

Problems and Solutions

Check the solutions below if you’re having trouble using the RX500 in stand-alone mode.

**Copying Problems**

- Make sure your paper is positioned on the right side of the sheet feeder behind the tab, with the left edge guide resting lightly against its left side. Don’t load paper above the arrow on the left edge guide.

- Make sure your paper is loaded short edge first.

- Make sure your original is positioned in the top left corner of the glass, with the top edge of the original facing left. Place it at least 0.1 inch from the edge of the glass to avoid cropping the image.

- Make sure you pressed the Copy button to enter copy mode.
■ Make sure to select the copy layout you want. See page 24 for instructions.

■ If you select Auto Fit Page to copy a document with white or very light edges, the original size may not be recognized. Select Actual as the Reduce/Enlarge setting (see page 23) and use the Optional Zoom setting to adjust the size of your copy (see page 27).

**Paper Feeding Problems**

■ If paper doesn’t feed, remove it from the sheet feeder. Fan the paper, load it against the right side behind the tab, and slide the left edge guide against the paper (but not too tightly).

■ If paper jams, follow these steps:
  1. Press the ◇ On button to turn off the RX500.
  2. Lift up the scanner unit and remove any paper that’s inside, including any small pieces that may have torn off.

  **Caution:**
  Clear paper jams by pulling the paper out towards the front of the RX500.
  Never pull the paper out in the direction of the sheet feeder.

  3. Reload the paper. Make sure the edges are not creased or folded.

  4. Turn the RX500 back on and press the ◇ Color button to clear the error.

**Copy Quality Problems**

If you have any problems with the quality of your copies, try these solutions:

■ Make sure the document is placed flat against the scanner glass. If only part of the image is blurred, your document may be wrinkled or warped.

■ Make sure the RX500 is not tilted or placed on an uneven surface.

■ Clean the print head; see page 109 for instructions.

■ If a dotted line appears in the image, clean the scanner glass with a soft, dry, lint-free cloth (paper towels are not recommended). If the glass is still not clean, use a small amount of glass cleaner on a soft cloth. Make sure you wipe off any remaining liquid. Don’t spray glass cleaner directly on the glass.
Make sure your paper isn’t damp, curled, or loaded face down; the printable side, which is usually whiter or brighter, should be face up. Load new paper face up. Use Epson papers for proper saturation and absorption of genuine Epson inks.

- Use a support sheet with special paper or load your paper one sheet at a time.
- If you see jagged vertical lines, align the print head as described on page 115.
- The ink cartridges may be old or low on ink; see page 111 for instructions on replacing an ink cartridge.

Where To Get Help

If you need help with the RX500 or Epson Scan software, see “Epson Support” below. If you need help with any other software included with the printer, see page 124.

Epson Support

Epson provides technical assistance 24 hours a day through the electronic support services and automated telephone services:

<table>
<thead>
<tr>
<th>Service</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>World Wide Web</td>
<td>From the Internet, you can reach Epson Support at <a href="http://support.epson.com">http://support.epson.com</a>. At this site, you can download drivers and other files, look at product documentation, access troubleshooting information, and receive technical advice through e-mail.</td>
</tr>
<tr>
<td>Automated Telephone</td>
<td>A variety of automated help services are available 24 hours a day, seven days a week. To use these services, you must have a touch tone telephone and call (800) 922-8911. Your Epson SoundAdviceSM Express Code is 70485. Use this code to quickly select the Stylus Photo RX500 in SoundAdvice.</td>
</tr>
<tr>
<td>Services</td>
<td></td>
</tr>
</tbody>
</table>
To speak to a technical support representative, dial:
■ US: (562) 276-4382, 6 AM to 6 PM, Pacific Time, Monday through Friday
■ Canada: (905) 709-3839, 6 AM to 6 PM, Pacific Time, Monday through Friday

Toll or long distance charges may apply.

Before you call, please have the following information ready:
■ Product name (Epson Stylus Photo RX500)
■ Product serial number (located on the back)
■ Proof of purchase and date of purchase
■ Computer configuration
■ Description of the problem

You can purchase ink cartridges, paper, manuals, and accessories from the Epson Store at (800) 873-7766, or visit www.epsonstore.com (U.S. sales only). In Canada, please call (800) 463-7766 for dealer referral.

**Other Software Technical Support**

<table>
<thead>
<tr>
<th>Software</th>
<th>Telephone</th>
<th>Online and E-mail</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Smart Panel</td>
<td>(510) 445-8616</td>
<td><a href="http://www.newsoftinc.com">www.newsoftinc.com</a> <a href="mailto:tech@newsoftinc.com">tech@newsoftinc.com</a></td>
</tr>
<tr>
<td>ArcSoft PhotoImpression</td>
<td>(510) 440-9901 8:30 AM–5:30 PM, Pacific Time, Monday through Friday</td>
<td><a href="http://www.arcsoft.com/techmain">www.arcsoft.com/techmain</a> <a href="mailto:support@arcsoft.com">support@arcsoft.com</a></td>
</tr>
<tr>
<td>ABBYY FineReader Sprint</td>
<td>(510) 226-6719</td>
<td><a href="http://www.abbyusa.com">www.abbyusa.com</a> <a href="mailto:support@abbyusa.com">support@abbyusa.com</a></td>
</tr>
</tbody>
</table>
Requirements and Notices

Windows System Requirements

To use your RX500 and its software, your system should have:

- Microsoft® Windows compatible PC with Pentium® 300 MHz or better processor
- Microsoft Windows 98 SE, Windows Me, Windows 2000, or Windows XP
- 128MB RAM (256MB or more of RAM recommended)
- VGA monitor or better with at least 256 colors
- At least 200MB of free hard disk space (300MB or more recommended)
- CD-ROM or DVD drive for installing the software
- Windows-compliant, built-in USB port and a shielded USB “AB” cable.

Macintosh System Requirements

To use the RX500 and its software, your system should have:

- iMac™ series, Power Macintosh® G3 or G4, PowerBook®, iBook™, or eMac™
- Mac® OS 8.6 through OS 9.x, or OS X 10.2 through OS X 10.3
  (Mac OS 9.1 or Mac OS 10.2 through 10.3 recommended)
- At least 128MB of available RAM (256MB or more recommended)
- At least 200MB of free hard disk space (300MB or more recommended)
- VGA monitor or better with at least 256 colors
- CD-ROM or DVD drive for installing the printer software
- Built-in USB port and a shielded USB “AB” cable.
Important Safety Instructions

Before using your RX500, read and follow these safety instructions:

■ Be sure to follow all warnings and instructions marked on the RX500.
■ Use only the type of power source indicated on the RX500 label.
■ Connect all equipment to properly grounded power outlets. Avoid using outlets on the same circuit as air control systems or other high-load devices that regularly switch on and off.
■ Place the RX500 near a wall outlet where the plug can be easily unplugged.
■ Don’t let the power cord become damaged or frayed.
■ If you use an extension cord with the RX500, make sure the total ampere rating of the devices plugged into the extension cord does not exceed the cord’s ampere rating. Also, make sure the total ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet’s ampere rating.
■ Avoid electrical outlets controlled by wall switches or automatic timers.
■ Keep your RX500 and computer away from potential sources of electromagnetic interference, such as loudspeakers or cordless telephone base units.
■ Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.
■ Leave enough room around the RX500 for sufficient ventilation.
■ Don’t place the RX500 near a radiator or heating vent or in direct sunlight.
■ Place the RX500 on a flat, stable surface that extends beyond its base in all directions. It will not operate properly if it is tilted or at an angle. Leave enough space in front of the RX500 (at least 9 inches) so it doesn’t tip forward and fall off of the work surface.
■ Turn off and unplug the RX500 before cleaning. Clean with a damp cloth only. Don’t spill liquid on it.
■ Always turn the RX500 off using the On button. Don’t turn off the power using a switch on a power strip or unplug the RX500 until the On light is off and Turning off disappears from the LCD panel.
■ Don’t block or cover openings in the RX500 case or insert objects through the slots.
■ Except as specifically explained in your documentation, do not attempt to service the RX500 yourself.
■ Unplug the RX500 and refer servicing to qualified service personnel under the following conditions: if the power cord or plug is damaged; if liquid has entered the product; if the product has been dropped or the case damaged; if the product does not operate normally or exhibits a distinct change in performance. Adjust only those controls that are covered by the operating instructions.
Before transporting the RX500, make sure the print head is capped in the far right position and secured by the orange print head holder or tape, and the scanner is secured by the transportation lock.

When storing or transporting the RX500, do not tilt it, stand it on its side, or turn it upside down. Otherwise ink may leak from the cartridge.

This product includes a lamp component that contains mercury (Hg). Please consult your state and local regulations regarding disposal or recycling. Do not put in the trash.

Don’t remove the memory card or turn off this product while the memory card light is flashing.

Use only memory cards compatible with the RX500.

See the documentation for your memory card for specific instructions about how to use the card.

**Ink Cartridge Safety Instructions**

- Leave the ink cartridges installed. Removing the cartridges can dehydrate the print head and may prevent the RX500 from printing.
- Keep ink cartridges out of the reach of children and do not drink the ink.
- Be careful when you handle used ink cartridges; there may be ink remaining around the ink supply port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them immediately with water.
- Don’t put your hand inside the RX500 or touch the cartridge during printing.
- Don’t move the print head by hand; you may damage the printer.
- Don’t shake cartridges after you remove them from their packages; this might cause leakage.
- Install the ink cartridge immediately after you remove it from its package. Leaving the cartridge unpacked for a long time before use may result in reduced print quality.
- Don’t use a cartridge beyond the date printed on the cartridge package. For best results, use up the ink cartridges within six months of installing them.
- Store ink cartridges in a cool, dark place. Store each ink cartridge so that the bottom of its package faces down.
- After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room temperature for at least three hours before using it.
- Don’t remove or tear the label on an ink cartridge; this can cause leakage.
■ Don’t dismantle cartridges or refill them; you could damage the print head.
■ Don’t touch the green IC chip on the cartridge. This may affect normal operation and printing.
■ If you remove an ink cartridge for later use, protect the ink supply area from dirt and store it in the same environment as the RX500. There is a valve in the ink supply port, making covers or plugs unnecessary, but care is needed to prevent the ink from staining items that the cartridge touches. Don’t touch the ink cartridge ink supply port or surrounding area.

**LCD Panel Safety Instructions**

■ Use only a dry soft cloth to clean the LCD display. Don’t use liquid or chemical cleaners.
■ If the LCD display is damaged, contact your dealer.
■ If LCD solution gets on your skin, wash it off thoroughly with soap and water. If it gets in your eyes, flush them immediately with water.
Legal Notices

FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio or television reception. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause interference to radio and television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC Certification of this device and may cause interference levels which exceed the limits established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this device. If this equipment has more than one interface connector, do not leave cables connected to unused interfaces. Changes or modifications not expressly approved by the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
Declaration of Conformity

According to 47CFR, Part 2 and 15 for: Class B Personal Computers and Peripherals; and/or CPU Boards and Power Supplies used with Class B Personal Computers:

We: Epson America, Inc.
Located at: MS 3-13
3840 Kilroy Airport Way
Long Beach, CA 90806
Telephone: (562) 290-5254

Declare under sole responsibility that the product identified herein complies with 47CFR Part 2 and 15 of the FCC rules as a Class B digital device. Each product marketed is identical to the representative unit tested and found to be compliant with the standards. Records maintained continue to reflect the equipment being produced can be expected to be within the variation accepted, due to quantity production and testing on a statistical basis as required by 47CFR §2.909. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Trade Name: Epson
Type of Product: Multifunction printer
Model: C171A

ENERGY STAR Compliance

As an ENERGY STAR® Partner, Epson has determined that this product meets the ENERGY STAR guidelines for energy efficiency. The EPA ENERGY STAR office equipment program is a voluntary partnership with the computer and office equipment industry to promote the introduction of energy-efficient personal computers, monitors, printers, fax machines, and copiers in an effort to reduce air pollution caused by power generation.
Epson America, Inc. Limited Warranty

What Is Covered: Epson America, Inc. ("Epson") warrants to the original retail purchaser that the Epson product covered by this limited warranty statement, if purchased new and used in the United States or Canada, conforms to the manufacturer’s specifications and will be free from defects in workmanship and materials for a period of one (1) year from the date of original purchase. Epson also warrants that the consumable ink cartridges enclosed with the product will perform to the manufacturer’s specified usage, which usage may expire before the expiration of the limited warranty for the Epson product. For warranty service, you must provide proof of the date of original purchase.

What Epson Will Do To Correct Problems: Should your Epson product prove defective during the warranty period, please call the Epson ConnectionSM at (562) 276-4382 (U.S.) or (905) 709-3839 (Canada) for warranty repair instructions and return authorization. An Epson service technician will provide telephone diagnostic service to determine whether the product requires service. If service is needed, Epson will, at its option, exchange or repair the product without charge for parts or labor. If Epson authorizes an exchange for the defective unit, Epson will ship a replacement product to you, freight prepaid, so long as you use an address in Canada or the U.S. (excluding Puerto Rico and U.S. Possessions). Shipments to other locations will be made freight collect. You are responsible for securely packaging the defective unit and returning it to Epson within five (5) working days of receipt of the replacement. Epson requires a debit or a credit card number to secure the cost of the replacement product in the event that you fail to return the defective one. If your product is being repaired, Epson will direct you to send your product to Epson or its authorized service center, where the product will be fixed and sent back to you. You are responsible for packing the product and for all costs to and from the Epson authorized service center. When warranty service involves the exchange of the product or a part, the item replaced becomes Epson property. The replacement product or part may be new or refurbished to the Epson standard of quality, and, at Epson’s option, may be another model of like kind and quality. Epson’s liability for replacement of the covered product will not exceed the original retail selling price of the covered product. Exchange products and parts assume the remaining warranty period of your original product covered by this limited warranty.

What This Warranty Does Not Cover: This warranty does not apply to refurbished or reconditioned products. This warranty covers only normal use in the United States and Canada. This warranty is not transferable. This warranty does not cover any color change or fading of prints or reimbursement of materials or services required for reprinting. This warranty does not cover damage to the Epson product caused by parts or supplies not manufactured, distributed or certified by Epson. This warranty does not cover ribbons, ink cartridges or third party parts, components, or peripheral devices added to the Epson product after its shipment from Epson, e.g., dealer or user-added boards or components. Epson is not responsible for warranty service should the Epson label or logo or the rating
label or serial number be removed or should the product fail to be properly maintained or fail to function properly as a result of misuse, abuse, improper installation, neglect, improper shipping, damage caused by disasters such as fire, flood, and lightning, improper electrical current, software problems, interaction with non-Epson products, or service other than by an Epson Authorized Servicer. If a claimed defect cannot be identified or reproduced, you will be held responsible for the costs incurred.

THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT OR FITNESS FOR A PARTICULAR PURPOSE. SOME LAWS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES. IF THESE LAWS APPLY, THEN ALL EXPRESS AND IMPLIED WARRANTIES ARE LIMITED TO THE WARRANTY PERIOD IDENTIFIED ABOVE. UNLESS STATED HEREIN, ANY STATEMENT OR REPRESENTATIONS MADE BY ANY OTHER PERSON OR FIRM ARE VOID. EXCEPT AS PROVIDED IN THIS WRITTEN WARRANTY, NEITHER EPSON AMERICA, INC. NOR ITS AFFILIATES SHALL BE LIABLE FOR ANY LOSS, INCONVENIENCE, OR DAMAGE, INCLUDING DIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES, RESULTING FROM THE USE OR INABILITY TO USE THE EPSON PRODUCT, WHETHER RESULTING FROM BREACH OF WARRANTY OR ANY OTHER LEGAL THEORY.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty lasts, and some jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the above limitations and exclusions may not apply to you. This warranty gives you specific legal rights, and you may have other rights which vary from jurisdiction to jurisdiction.

Epson America, Inc. ■ P.O. Box 93012 ■ Long Beach, CA 90809-3012
Index

A
Aligning print head, 115 to 117

B
Borderless printing, 24, 41 to 42, 51 to 54, 98

C
Canceling copies, 27
Cleaning print head, 109 to 110
Color Management, turning off, 45, 50
Color Restoration setting, 58
ColorSync, 45
Copying
  adjusting shade, 26
  borderless photos, 24
  canceling, 27
  changing copy size, 23, 27
  from card to computer, 85 to 88
  layout settings, 24 to 25
  number of copies, 22
  paper size, 23
  paper type, 22
  print quality, 23
  problems, 121 to 123
  restoring defaults, 27
  saving settings, 26
  thick documents, 20, 29
  with a computer, 28 to 33

D
Date, adding to prints, 103
Declaration of Conformity, 130
Default settings, 27, 38
Digital noise, removing, 100
Documentation, description, 10
DPOF images, printing, 94 to 96

E
Editing scanned text, 59
E-mail, scanning files to, 59, 81 to 82
Envelopes, 17 to 18
EPSON Scan, starting, 61, 64
Exif Print, 7, 100

F
Fax, scanning to, 59
FCC statement, 129
Film holder, 75 to 77
Film, scanning, 74 to 79
Fit to Frame setting, 104
Full Auto Mode, 63

H
Help, 123 to 124
Hi Speed setting, 105
Home Mode, 63, 64 to 66
Index forms, 89 to 93
Ink cartridge
  ordering, 111 to 112
  replacing, 111 to 114
  safety instructions, 127 to 128
Ink Jet Transparencies, loading, 15
Iron-On Transfer Paper, loading, 16

Layout settings
  copy, 24 to 25
  print, 40, 45, 98

Macintosh
  automatic photo copying, 86 to 88
  color management settings, 45, 50
  controlling printing, 45 to 46, 48
  page layout settings, 43, 45, 47
  photo printing, 51 to 54
  print quality, 45, 48
  removing memory card, 85
  system requirements, 125
Marquee, adjusting, 67

Memory cards
  adding date to prints, 103
  adding time to prints, 103
  compatible, 83
  copying files to and from, 85 to 88
  digital noise, 100
  Fit to Frame setting, 104
  Hi Speed setting, 105
  inserting and removing, 84 to 85
  layout settings, 98
  paper type settings, 96 to 97
  print information, adding, 104
  printing DPOF images, 94 to 96
  requirements, 83
  scanning to, 105 to 107
  selecting photos, 92 to 94
  sepia tone, 99
Monitored printing, 38, 45 to 46, 48
Moving RX500, 118 to 119

Nozzle check, printing, 110
P
Paper
  copy settings, 22
  feed problems, 122
  for borderless printing, 51
  loading, 13 to 16
  memory card settings, 96 to 97
  ordering, 124
  settings in printer driver, 54 to 55
Photo RPM, 39, 49, 50
Photo Stickers, loading, 16
Photos
  printing, 41 to 42, 51 to 54
  restoring color, 58, 68 to 74
  sharing on web, 59
Previewing scans, 65
Print head
  aligning, 115 to 117
  cleaning, 109 to 110
PRINT Image Matching, 7, 100
Print quality, 23, 37, 39, 45, 48, 49, 50
Problems
  copy quality, 122 to 123
  copying, 121 to 122
  paper feeding, 122
Professional Mode, 63, 64 to 66

R
Red-eye correction, 58
Resolution, enhancing, 100
Restoring color in photos, 58, 68 to 74
Restoring default setting, 27

S
Safety instructions, 126 to 128
Scanning
  adjusting image size, 67
  film and slides, 74 to 79
  Full Auto Mode, 63
  Home Mode, 63, 64 to 66
  previewing scans, 65
  Professional Mode, 63, 64 to 66
  to application, 59, 63 to 66
  to editable text, 59
  to e-mail, 59, 81 to 82
  to fax, 59
  to file, 60 to 62, 79 to 80
  to memory card, 105 to 107
Sepia tone, printing with, 99
Slides, scanning, 74 to 79
SmartPanel
  copying, 28 to 33
  using, 58 to 59
Software, description, 11
Supplies, ordering, 124
Support, 123 to 124
System requirements, 125

T
Technical support, 123 to 124
Text files, scanning to, 59
Time, adding to prints, 103
Transporting RX500, 118 to 119
W
Warranty, 131 to 132
Windows
  automatic photo copying, 86 to 87
  controlling printing, 38
  default settings, 38
  page layout settings, 40
  photo printing, 41 to 42
  print quality, 37
  system requirements, 125
Epson Stylus Photo RX500 Parts

How To Order Epson Ink and Paper

To order Epson ink cartridges and paper, contact your dealer or call the Epson Store at (800) 873-7766, or visit www.epsonstore.com (U.S. sales only). In Canada, please call (800) 463-7766 for dealer referral.

Epson Ink Cartridges

Black: T048120
Cyan: T048220
Light Cyan: T048520
Magenta: T048320
Light Magenta: T048620
Yellow: T048420

Epson Papers

<table>
<thead>
<tr>
<th>Paper name</th>
<th>Size</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Premium Bright White Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041586</td>
</tr>
<tr>
<td>Epson Photo Quality Ink Jet Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041062</td>
</tr>
<tr>
<td></td>
<td>A4 (8.3 x 11.7 inches)</td>
<td>S041061</td>
</tr>
<tr>
<td></td>
<td>Legal (8.3 x 14 inches)</td>
<td>S041067</td>
</tr>
<tr>
<td>Epson Photo Paper</td>
<td>Panoramic (8.3 x 23 inches)</td>
<td>S041145</td>
</tr>
<tr>
<td>Epson Glossy Photo Paper</td>
<td>Borderless 4 x 6 inches, non-perforated</td>
<td>S041458</td>
</tr>
<tr>
<td></td>
<td>4 x 6 inches, perforated edges</td>
<td>S041134/S041671</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041141/S041649/ S041272/S041271</td>
</tr>
<tr>
<td>Epson ColorLife Photo Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041500</td>
</tr>
<tr>
<td>Epson Matte Paper Heavyweight</td>
<td>Borderless 8 x 10 inches</td>
<td>S041467</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041257</td>
</tr>
<tr>
<td>Epson Double-Sided Matte Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041568</td>
</tr>
<tr>
<td>Epson Premium Glossy Photo Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041286/S041667</td>
</tr>
<tr>
<td></td>
<td>Borderless 4 x 6 inches</td>
<td>S041727</td>
</tr>
<tr>
<td></td>
<td>Borderless 5 x 7 inches</td>
<td>S041464</td>
</tr>
<tr>
<td></td>
<td>Borderless 8 x 10 inches</td>
<td>S041465</td>
</tr>
<tr>
<td>Epson Premium Semigloss Photo Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041331</td>
</tr>
<tr>
<td>Epson Premium Luster Photo Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041405</td>
</tr>
<tr>
<td>Epson Photo Quality Self Adhesive Sheets</td>
<td>A4 (8.3 x 11.7 inches)</td>
<td>S041106</td>
</tr>
<tr>
<td>Epson Ink Jet Transparencies</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041064</td>
</tr>
<tr>
<td>Epson Iron-On Transfer Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041153</td>
</tr>
<tr>
<td>Epson Glossy Photo Greeting Card Kit</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041606</td>
</tr>
<tr>
<td>Epson Semigloss Scrapbook Photo Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>SCR1001</td>
</tr>
<tr>
<td>PremierArt Matte Scrapbook Photo Paper for Epson</td>
<td>Letter (8.5 x 11 inches)</td>
<td>SCR1002</td>
</tr>
</tbody>
</table>
Epson Stylus Photo RX500 Parts

How To Order Epson Ink and Paper
To order Epson ink cartridges and paper, contact your dealer or call the Epson Store at (800) 873-7766, or visit www.epsonstore.com (U.S. sales only). In Canada, please call (800) 463-7766 for dealer referral.

Epson Ink Cartridges
- Black: T048120
- Cyan: T048220
- Light Cyan: T048520
- Magenta: T048320
- Light Magenta: T048620
- Yellow: T048420

Epson Papers

<table>
<thead>
<tr>
<th>Paper name</th>
<th>Size</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Premium Bright White Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041586</td>
</tr>
<tr>
<td>Epson Photo Quality Ink Jet Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041062</td>
</tr>
<tr>
<td></td>
<td>A4 (8.3 x 11.7 inches)</td>
<td>S041061</td>
</tr>
<tr>
<td></td>
<td>Legal (8.3 x 14 inches)</td>
<td>S041067</td>
</tr>
<tr>
<td>Epson Photo Paper</td>
<td>Panoramic (8.3 x 23 inches)</td>
<td>S041145</td>
</tr>
<tr>
<td>Epson Glossy Photo Paper</td>
<td>Borderless 4 x 6 inches, non-perforated</td>
<td>S041458</td>
</tr>
<tr>
<td></td>
<td>4 x 6 inches, perforated edges</td>
<td>S041134/S041671</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041141/S041649/ S041272/S041271</td>
</tr>
<tr>
<td>Epson ColorLife Photo Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041500</td>
</tr>
<tr>
<td>Epson Matte Paper Heavyweight</td>
<td>Borderless 8 x 10 inches</td>
<td>S041467</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041257</td>
</tr>
<tr>
<td>Epson Double-Sided Matte Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041568</td>
</tr>
<tr>
<td>Epson Premium Glossy Photo Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041286/S041667</td>
</tr>
<tr>
<td></td>
<td>Borderless 4 x 6 inches</td>
<td>S041727</td>
</tr>
<tr>
<td></td>
<td>Borderless 5 x 7 inches</td>
<td>S041464</td>
</tr>
<tr>
<td></td>
<td>Borderless 8 x 10 inches</td>
<td>S041465</td>
</tr>
<tr>
<td>Epson Premium Semigloss Photo Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041331</td>
</tr>
<tr>
<td>Epson Premium Luster Photo Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041405</td>
</tr>
<tr>
<td>Epson Photo Quality Self Adhesive Sheets</td>
<td>A4 (8.3 x 11.7 inches)</td>
<td>S041106</td>
</tr>
<tr>
<td>Epson Ink Jet Transparencies</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041064</td>
</tr>
<tr>
<td>Epson Iron-On Transfer Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041153</td>
</tr>
<tr>
<td>Epson Glossy Photo Greeting Card Kit</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041606</td>
</tr>
<tr>
<td>Epson Semigloss Scrapbook Photo Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>SCR1001</td>
</tr>
<tr>
<td>PremierArt Matte Scrapbook Photo Paper for Epson</td>
<td>Letter (8.5 x 11 inches)</td>
<td>SCR1002</td>
</tr>
</tbody>
</table>

USB cable (not included)